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Getting Started
Your IDEXX-PACS* Imaging Software works with your IDEXX Diagnostic Imaging system to
deliver diagnostic radiographs without film or chemical development.
In this chapter, you'll find information about:

l Learning resources
l Using the Home window and finding a patient record
l How images are organized in order of study, series, and image
l How to determine which IDEXX Diagnostic Imaging system you have
l Accessing other programs, like VetConnect* PLUS
l Logging off and switching users
l Keyboard shortcuts

Tip: To save thisOperator’s Guide to your computer, the network, or a CD, at the top of the PDF
window, select File > Save as as.

Statement of Intended Use

The IDEXX Diagnostic Imaging systems are intended for veterinary use only; they are not
intended for human diagnostic use. For a detailed list of species and settings, contact IDEXX
Diagnostic Imaging Customer Support at 1-877-433-9948.

About Your IDEXX Diagnostic Imaging Hardware

Identifying Your Diagnostic Imaging System

There are two types of IDEXX Diagnostic Imaging systems—computed radiography (CR) and
digital radiography (DR).
It's easy to determine which system you have:
An IDEXX CR system uses a portable cassette containing a phosphor screen that replaces x-
ray film. After you capture an image, you insert the cassette into a scanner, which reads the
digital x-ray image without chemical developing. The images are stored and reviewed using the
IDEXX-PACS* software.
An IDEXX DR system does not have a portable cassette or scanner. In a DR system the
detector panel is attached to the underside of the radiography table. When you take a
radiograph, the high-resolution detector plate is exposed to the x-ray source, and the x-rays are
converted immediately into electrical signals that are read by the DR system and displayed on
the monitor in just a few seconds.

Finding Your IDEXX-PACS Version Number

On the IDEXX-PACS Home window, clickHelp > About IDEXX-PACS.

Cleaning and Maintaining Your System

For optimal performance, restart your IDEXX-PACS system every 24 hours.
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Getting Started

For technical specifications and for information on equipment maintenance, service, transportation,
and storage for all IDEXX CR and DR systems, see the IDEXX Diagnostic Imaging Systems Hardware

Guide available on the Help menu in IDEXX-PACS Software. The guide is also located in the folder
where your IDEXX Diagnostic Imaging software is installed.

System Requirements

Operating system recommendations
Operating system recommendations and requirements are slightly different for computers used to
capture images with IDEXX Diagnostic Imaging systems and computers used for reviewing images and
using other software features:

l When capturing images, use only computers that are supplied by IDEXX.
l When reviewing images and using other features (except image capture), use a computer running
the Windows* 10 or later Professional or Enterprise operating system.

The Patient CD feature can be used with home or business editions of Windows operating systems. The
Patient CD is not compatible with the Mac* OS X* operating system.
Minimum hardware requirements
Your image-capture computer is provided by IDEXX and will meet IDEXX requirements. However, if you
run the IDEXX-PACS software on any other computers, for example for image viewing, these computers
must meet the following minimum requirements

RAM: Internet speeds:
– 4.0 GB RAM (Windows 32-bit operating system) – Upload: 5 Mbps
– 8.0 GB RAM (Windows 64-bit operating system) – Download: 10 Mbps
Intel* dual-core processor or better Monitor resolution:
20 GB free space on hard drive – Minimum: 1024 x 768
CD/DVD burner – Recommended: 1280 x 1024 or higher
100/1000 Mbps Ethernet port

Contact IDEXX Diagnostic Imaging Customer Support if you need help upgrading RAM or freeing disk
space.
To capture images with IDEXX Diagnostic Imaging systems, use only computers provided by IDEXX.

Using the IDEXX-PACS Home Window

Using the Home Window on a Capture Station

From the IDEXX-PACS Home window on your image-capture computer you can:

l Find a patient record. See "inding Patient Images and Records" on page 8.

l Use the Tools button to:
o Import DICOM® files and use DICOM query and retrieve.
o Archive or back up your images.
o Erase cassettes (for IDEXX I-Vision CR systems).
o View the radiology log.

l Use the System Settings button to set software options.
l Start an image capture request (if you did not start it from your practice management software). See
"Starting a Capture Request from the IDEXX-PACS* Software" on page 13 for more information.
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Home window on capture station

To minimize or resize the Home window:

In the upper right corner of the Home window, click Resize to display the minimize, resize, and
close buttons .

Using the Home Window on a Noncapture Station

The IDEXX-PACS Home window displays image-capture tools only on computers designated as
image-capture stations.
If a computer is not used for image capture, the Home window does not display Capture or STAT
buttons or the Pending list. You can still use the Home window to select a patient record to review its
images. You can also use the Patient button to add a new patient record and import images into it.
Computers are designated as either image-capture or noncapture (i.e., viewing stations) when your
system is installed. To change a computer’s designation, contact IDEXX Diagnostic Imaging Customer
Support.

inding Patient Images and Records

To find a patient record and review images:

1. In the Home window, search for patients either of these ways:
l In the Search box, enter a patient or client name or ID and click .
OR

l Click a time period (such as This Week), and then select an optional filter, such as a species.

A patient card is displayed for each patient found.
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2. To open the study, click the thumbnail area. An image from the current study opens in the Image
Viewer.

If there are no thumbnails in the patient card, clicking in the thumbnail area still opens the Image
Viewer, so that you can import or capture images for the patient, update the patient record, and
perform other tasks.

Using the Patient Card

A patient card summarizes information about the patient and the study including:

l Patient name, ID, and other information

Note: If the patient ID is surrounded by parentheses, e.g., (1234), the number was generated by the
IDEXX-PACS software. If the patient ID is surrounded by square brackets, e.g., [1234], the number
is from your practice information management system (PIMS). If you see [Add ID] following the
patient name, IDs are being assigned by your PIMS, but this patient record doesn’t have an ID; click
Add ID to assign one.

l Study name (the default name is the study date)
l Thumbnail images; each stack represents a series containing the indicated number of images
l Paper clip if the study is associated with a telemedicine case; click the paperclip for details
l Heart icon if the study includes an ECG file
l Menu with options to share, print, or save images
l Image capture button

A patient card. The study contains one series with two images.

About Image, Series, and Study

Captured images are organized into a hierarchy as follows:

l Image—A single radiograph; the image name is the name of the shot, such as “THX - Lat"
l Series—A group of related images, usually of the same body part or region; the series name is the
exam category, such as “Thorax-Routine"

l Study—A group of series that were captured at the same time; the study name is the date and time
you began the capture process

To change image, series, or study names:

Use the study panel to edit image details in the Image Viewer.

The DICOM standard requires series and study information to be recorded for every image, even if you
take only a single radiograph. In that case, there will be a single image in the series and a single series in
the study.
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Because the terms "series" and "study" are part of the DICOM standard, you may encounter them when
using other DICOM-compliant equipment, such as endoscopes or ultrasoundmachines.

Accessing VetConnect* PLUS, VetMedStat*, and IDEXX Pet Health Network* Pro

1. In the Home window, click in the upper left corner.
2. Click the icon (not the name) of the website you want to visit.

If you don’t have a logon for the website, click the link on the logon page to create an account or to find
contact information.

Websites:

l VetConnect* PLUS—All your IDEXX diagnostic results side-by-side
l VetMedStat*—The website for IDEXX Telemedicine Consultants
l IDEXX Pet Health Network* Pro—Easy-to-use tools for pet owner communication and education

Switching Users and Exiting IDEXX-PACS

If staff members have different levels of access to software features, the current user should log off
before another staff member uses the system. For more information, see "Setting Up Staff
Classifications" on page 87
Note: An "access denied" message is displayed if a user does not have access to a specific window or
feature.

To log off before switching users:

1. Click your user name in the upper right corner of the window, and then select Log off.
2. ClickOK. The logon box is displayed so another user can log on.

To exit the software:

1. Click your user name in the upper right corner of the window, and then select Exit. You are
prompted to back up your system.

2. (Optional) Select backup options as needed.
3. ClickOK.

Shortcuts and Touch-Screen Gestures

Windows* Keyboard Shortcuts

The following shortcuts work with most Windows*-based software.
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Task Shortcut

Close a menu Click outside the menu.

Select a group of noncontiguous
items

Hold down the CTRL key while clicking the
individual items.

Select a group of contiguous
items

Click the first item in the group, and then hold
down the SHIFT key while clicking the last item in
the group.

Deselect items
Hold down the CTRL key while clicking a selected
item.

Select an area of an image
Hold down the mouse key while dragging the
pointer across the area you want. This is called
“click and drag.”

Sort table information
Click the column name to sort by that column.
Click the column name again to reverse the sort
order.

Open folders Click the plus sign (+).

Close folders Click the minus sign (-).

Display drop-down lists Click the down-arrow next to the list name.

IDEXX-PACS* Imaging Shortcuts
Imaging shortcuts let easily move or enhance an image in the Image Viewer.
Notes:

l To use imaging shortcuts, you must first enable them as described below.
l Shortcuts involving the right mouse button do not work with touch-screen monitors.

To activate imaging shortcuts:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickUser Settings.
3. Select Enable Imaging Shortcuts.
4. Click Save.
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Imaging shortcuts
Task Shortcut

Rotate image 90°
counterclockwise

Press the A key.

Rotate image 90° clockwise Press the S key.

Change the window (contrast)
Hold down the left mouse button andmove the
mouse left and right (touch screen: drag finger
left/right).

Change the level (brightness)
Hold down the left mouse button andmove the
mouse up and down (touch screen: drag finger
up/down).

Return to original window/level
settings

Double-click the left mouse button (touch screen:
double tap).

Zoom
Hold down the right mouse button andmove the
mouse.

Return to original zoom (image
fits in window)

Double-click the right mouse button.

Move a magnified area around
the image

Hold down the SHIFT key, and click the right
mouse button.

Touch-Screen Gestures

Use these gestures if you have a touch-screen monitor.
Task Gesture

Select an item Tap once.
Select a group of contiguous
items Touch and drag to select the range of items.

Start a program from the desktop Tap twice quickly.

Display a "right-click" menu
Hold one finger on the touch screen while you
tap with a second finger.

Pan an image in the Image
Viewer

Hold one finger on the image and drag left or
right. (You can pan only when the image is
larger than the window.)

Change the window/level
(contrast/brightness)

Imaging shortcuts must be turned on. Hold two
fingers on the image in the Image Viewer and
drag left or right.

Enter text or number
Tap once in the data-entry box. An onscreen
keyboard or number pad appears. Tap the
letters or numbers.
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Capturing Images
There are four steps in the image capture process:

1. Start the capture request from the IDEXX-PACS software or from your practice management
system.

2. Select the radiographs you want to take.
3. Capture the radiographs(s), following the appropriate instructions in this chapter for your
digital imaging system.

4. Review the radiographs. You can enhance, retake, or reprocess images, as needed.

You'll find basic instructions in this chapter. For additional information, see:

l Chapter 3, "Using Advanced Image Capture Tools" on page 28 for tools you can use to
capture better radiographs.

l Chapter 4, "Viewing and Enhancing Images after Capture" on page 33 for tools you can use
to enhance or annotate images after capture.

Starting a STAT Image Request

To start a STAT image request:

1. In the IDEXX-PACS Home window, click .
2. At the bottom of the Add Shots window, select the species.
3. Select a body region, and then select individual shots (or click a series name to select an
entire series). The capture window opens with the shots listed on the right.

4. After you capture the image(s), click . The Home page opens containing a patient
card labeled STAT patient.

5. Click in the patient card to assign the study to the correct patient. For more information,
see "Reassigning a Study " on page 50.

Note:If your IDEXX-PACS software is integrated with your Cornerstone software, always reassign
the STAT images in the IDEXX-PACS software, not in the Cornerstone software. This way the
updated information will be returned to Cornerstone, and the Cornerstone record will be updated
accordingly.

See also:

Reassigning a Study to Another Client or Patient

Starting a Capture Request from the IDEXX-PACS* Software

Note: If your IDEXX-PACS Software is integrated with Cornerstone Software or another practice
management system, start the image capture request from that system. See "Starting the
capture request from the Cornerstone* Software or other integrated systems" on page 14. If your
IDEXX-PACS software is not integrated with your practice management system, follow
instructions below.
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To start a capture request for an existing patient:

1. In the IDEXX-PACS Home window, find the patient record.

2. In the patient card click .
3. Select the shots.

To start a capture request for a new patient:

1. In the IDEXX-PACS Home window, click , and then clickNew Patient.
2. Enter the patient and client information, and then click Save and Continue.
3. Select the shots.

To start a capture request from the Image Viewer:

1. Click in the lower right corner of the Image Viewer to capture images for the current patient.
2. Select the shots.

Starting the capture request from the Cornerstone* Software or other integrated systems

Some practice management systems, such as Cornerstone* Software and AVImark* Software, can be
closely integrated with your IDEXX Diagnostic Imaging software. If your systems are integrated:

l You can start radiograph requests from the practice management software. The requests will be
sent automatically to the IDEXX-PACS software and will be displayed in the Pending list in the Home
window.

l Captured images will be returned automatically to the patient record in the practice management
system and will be added to the patient invoice.

To fulfill a request from your practice management system:

1. Request the radiograph through your practice management system.
2. In the IDEXX-PACS Home window, find the patient name in the Pending list and click the capture

icon . (If the list isn’t visible, click to display it.)

Tip: To see only the most recent requests, click Last 24 hrs above the list.

3. If the shots were not specified in the initial request, the Add Shots window opens; select the shots.
See "Selecting the Shots" on page 16. If radiographs were specified in the request, the capture
window opens with the requested shots listed on the side.

4. Capture the images. See "Capturing Images" on page 13.

Tips:

l Depending on your practice management software, you may be able click an X on the request row
to delete a single request or click aClear list option to delete all requests.

l You can also choose patients from the Census list, which lists all patients currently checked-in
through your practice management system. In this case, you will need to select the shots from the
Add Shots window.
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Starting the Capture Request Using Modality Worklist

The modality worklist feature enables your IDEXX Diagnostic Imaging software to communicate with
any DICOM®-enabled practice information management system.
Using modality worklist, you can: 

l Start image-capture requests from the practice management system by adding them to a modality
worklist queue. The requests appear on the IDEXX-PACS Pending list.

l Track the status of the requests from your practice management software.

IMPORTANT: To set up a modality worklist connection between IDEXX-PACS software and your
practice management system, you must configure your practice management system as a remote
DICOM server. See "Configuring Remote DICOM Servers or Modality Worklist Connections" on page 76.

To start the image request:

Refer to your practice management system user guide. The steps depend on your system.
Important: Always include notes that specify the shots to be taken.

To fulfill the image request:

1. In the Home window of the IDEXX-PACS software, find the request in the Pending list and click the

capture icon .

Tip: To see only the most recent requests, click Last 24 hrs above the list.

2. Look for the image request notes in the Request Notes box on the Add Shots window, and then
select the specified shots. See "Selecting the Shots" on page 16.

If the request is not on the Pending list:

1. Above the Pending list, click Advanced Search.
2. Enter search criteria (patient name, patient ID, image source, status, and/or date), and then click
Search.

3. View the status of the request in the Status column:
l Scheduled—The request was created, but the capture process has not started.
l Arrived—You will see this status only if your practice information management system uses it.
l Ready—You will see this status only if your practice information management system uses it.
l Started—You began the capture process but exited before capturing the images.
l Discontinued—The request has been discontinued.
l Completed—Radiographs have been captured.

4. To fulfill a request, select the request, and then clickCapture.

Or

To cancel a request, select the request, and then clickDiscontinue.

To monitor the modality worklist queue:

1. In the Home window, click (button color may be different).
2. On the MWL row, clickQueue.
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Selecting the Shots

The Add Shots window opens after you start an image-capture request.
In most cases, you see a species illustration called the Visual Shot Tree. (You will see a text list of
species if the patient is not canine or feline.)

Visual Shot Tree

To select shots from the Visual Shot Tree:

1. For STAT patients only, select the correct species in the lower left corner of the window

. (Clicking displays a text list of species and shots.)

2. In the information panel at the top of the window, review any request notes, and update study and
other information as needed.

Note: This is the only opportunity to change the study title. After you leave this window, the study
title will no longer be editable.

3. Click an anatomical region to see a list of available shots.
4. Select individual shots from the list, or to select an entire series of shots, click the series name.
5. Repeat steps 3–4 to add other shots as needed. You can add shots in any order and can add the
same shot more than once.

6. ClickDone. The Capture window opens; the selected shots are listed on the right.
7. (Optional) To select additional special shots, such as repeated shots at timed intervals, select the
shot on the Capture window, and then click the Add Options tab. For more information, see "Using
Special Shot Options" on page 28

8. To capture the images, follow the instructions that apply to your digital imaging system.
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Capturing Images with an ImageVue DR30 or ImageVue DR50 Digital Imaging System

Before you capture images, check the detector status to ensure the detector is ready.

Detector status

ImageVue DR30:

l The two status LEDs (where the LAN cable connects to the detector) should display steady

green and flashing yellow .
l In the IDEXX-PACS Capture window, the cable icon should indicate connected .

For additional information about the status lamps and what they may indicate, refer to the hardware

guide available from the softwareHelp menu.

ImageVue DR50 wired:

l The detector must be connected by cable to the ImageVue Power Box or Power Supply Unit
(depending on your system version).

l In the IDEXX-PACS Capture window, the cable icon should indicate connected .

ImageVue DR50 wireless:

l A wireless access point must be connected; the detector cable must be disconnected.

l In the IDEXX-PACS Capture window, the wireless icon should indicate active .
l The detector battery must be inserted; the battery icon should indicate an adequate charge

If the detector status does not indicate ready, check all cable, wireless, and power connections and
switches. Contact IDEXX Diagnostic Imaging Customer Support if needed.

Capturing images

IMPORTANT:Do not run other software programs while capturing images. Running other
programs could result in data loss.

1. By default the first shot in the list is already selected for capture; to choose a different shot, click
the shot name to select it.

IMPORTANT: For best image quality, the body part that you are imagingmust match the
selected shot. The shot type determines image processing values and image orientation.

2. Some shot types display a>10 cm or a>15 cm check box. Select this check box if the region
to be radiographedmeets this size specification. This ensures the correct imaging processing
parameters are applied.

3. (Optional) Click Add Options to enter any special additional shots, such as those for a
urogram.

4. Position the animal on the table, measure the thickest part of the anatomy to be radiographed,
and set generator technique accordingly using the technique chart provided by IDEXX.

5. Set physical markers.
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6. After the system beeps and the ready button has turned green, prep the x-ray switch by
pressing the foot pedal half-way down (not all the way).

7. Press the switch all the way to capture the image.Note: For best image quality, take the image
within 10 seconds of the signal. If more than 10 seconds elapse, release the switch and re-prep
the system.

IMPORTANT:When taking an image, do not perform any other operation on your computer
(e.g., printing, entering data, or emailing).

You will know that the x-ray generator has fired when you see a message that the image is being
captured. The generator makes its standard exposure notification.

The processed image is displayed in the IDEXX-PACS Capture window with a dashed-line crop
border:

l To accept this crop area, click the image, and then clickCrop , or simply
capture another image.

l To set a new crop area, click and drag the dotted crop line as needed, and then

clickCrop .
l To reject the crop area, click within the cropped area and then clickDelete .

In the capture list, the captured image is surrounded by a light border, and the next shot is
selected for capture.

Tip:To capture a different image, click the shot you want.

8. Take any remaining radiographs.

Tips:

l To add any additional shots to the list, click Add Shots at the top of the capture list.
l To pause the capture session, click Pause in the lower right corner of the window.
For more information, see "Pausing a Study" on page 22.

9. Before completing the capture session, it’s a good idea to review each image. To review each
image, click the image name in the capture list. For more information, see "Checking and
Approving Images" on page 22.

If necessary, you can retake, replace, or delete an image. For more information, see "Retaking,
replacing, or deleting radiographs" on page 26.

10. When finished, clickDone. The images are saved, and the Home window is redisplayed.
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Capturing Images with Other IDEXX DR Systems

IMPORTANT:Do not run other software programs while capturing images. Running other programs
could result in dataloss.
Other IDEXX DR systems include the ImageVue* DR40, IDEXX I-Vision DR*, and IDEXX-DR* 1417
Digital Imaging System.

To capture images:

1. By default, the first shot in the list is already selected for capture; to choose a different shot, click the
shot name to select it.

IMPORTANT: For best image quality, the body part that you are imaging must match the selected
shot. The shot type determines image processing values and image orientation.

2. (Optional) Click Add Options to enter any special additional shots, such as those for a urogram.
3. Position the animal on the table and set generator technique accordingly using the technique chart
provided by your installer.

4. Set physical markers and then prep the x-ray switch by pressing the foot pedal half-way down (not
all the way).

You will see a message that the system is prepping. Other signs that the system is prepped include
(depending on your system):

l The system beeps.
l The relay box LED changes from blinking red to blinking green. (In systems without the
relay box, the light on the small black switch box turns from green to red, and the green
light on the white interface box is illuminated).

l The x-ray generator tube makes the sounds that it usually makes when preparing to
fire.

5. Press the switch all the way to capture the image.Note: For best image quality, take the image
within 10 seconds. If more than 10 seconds elapse, release the switch and re-prep the system.

You will know that the x-ray generator has fired when you see a message that the image is being
captured. The generator makes its standard exposure notification.

IMPORTANT:When taking an image, do not perform any other operation on your computer (e.g.,
printing, entering data, or emailing).

The processed image is displayed with a dashed-line crop border:

l To accept this crop area, click the image, and then clickCrop , or simply capture
another image.

l To set a new crop area, click and drag the dotted crop line as needed, and then click

Crop .
l To reject the crop area, click within the cropped area, and then clickDelete .

In the capture list, the captured image is surrounded by a light border, and the next shot is selected
for capture.

Tip:To capture a different image, click the shot you want.

6. Take any remaining radiographs.
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Tips:

l To add shots to the list, click Add Shots at the top of the capture list.
l To pause the capture session, click Pause in the lower right corner of the window. For
more information, see "Pausing a Study" on page 22.

8. Before completing the capture session, it’s a good idea to review each image. To review each
image, click the image name in the capture list. For more information, see "Checking and Approving
Images" on page 22.

If necessary, you can retake, replace, or delete an image. For more information, see "Retaking,
replacing, or deleting radiographs" on page 26.

9. When finished, clickDone. The images are saved, and the Home window is redisplayed.

Capturing Images with the IDEXX I-Vision CR* System

IMPORTANT:Do not run other software programs while capturing images. Running other programs
could result in data loss.

To capture images:

1. By default the first shot in the list is already selected for capture; to choose a different shot, click
the shot name to select it.

The currently selected shot is surrounded by a light border.

IMPORTANT: For best image quality, the body part that you are imaging must match the
selected shot. The shot type determines image processing values and image orientation.

2. Use the technique chart provided by your installer to select suitable exposure time and kVp
settings.

3. Position the animal on the table, and take the radiograph(s).
4. Insert the cassette into the scanner.

Note: If the scanner is unable to identify the cassette size, a window opens so that you can
specify the size.

5. ClickCapture. A scanning message appears on the screen, and the light(s) on the front of the
scanner is/are green and blinking.

IMPORTANT:While the plate is being read, do not perform any other operation on your
computer (e.g., printing, entering data, or emailing).

When the scan is complete, the scanner interface closes, and the image is displayed in the main
window.

The image is preserved, and an arrow points to the next shot in the list. Tip: To capture a
different image, select the shot you want.

6. Scan another cassette when both lights are green and steady.
7. Repeat the steps above until you have taken all the images for this patient.

Tips:

l To take additional shots, click Add Shots at the top of the capture list.
l To pause the capture session, click Pause in the lower right corner of the window.
For more information, see "Pausing a Study" on page 22.
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8. Before completing the capture session, it’s a good idea to review each image. To review each
image, click the image name in the capture list. For more information, see "Checking and
Approving Images" on page 22.

9. If necessary, you can retake, replace, or delete an image. For more information, see "Retaking,
replacing, or deleting radiographs" on page 26.

10. When finished, clickDone. The images are saved, and the Home window is redisplayed.

Working with the Capture Window

To review or edit study information:

1. At the top of the capture window, click the down-arrow next to the study title to review any image
request notes and to update the technician or veterinarian names if needed.

2. Click the up-arrow to close the panel.

To select a shot to capture:

The first shot is always selected by default in the capture list on the right, but you can select shots in any
order; just click the shot you want.
The selected shot is surrounded by a light border, and an arrow points to the next shot to be captured.
If there are any shots not captured when you reach the bottom of the list (you chose to skip them), the
first of the not-captured shots is selected.
For ImageVue DR50 systems, some shot types display a>10 cm or a>15 cm check box. Select this
check box if the region to be radiographedmeets this size criterion. This ensures the correct imaging
processing parameters are applied.

To add special shots, such as timed series:

Click the shot name in the capture list, and then click Add Options. Enter the required information.
Additional shots are added to the capture list as needed.

To add more shots:

Click at the top of the capture list.
Note: For IDEXX-DR systems, the software adds a new "miscellaneous" shot after you've captured all
shots in the current list. The miscellaneous shot applies the processing settings for the last shot you

took. If you want to take an image of a different body region, always click instead of using
the miscellaneous shot. This way you can select the correct body region and shot, to ensure the proper
settings for best quality.

To delete shots:

ClickDelete next to the shot in the capture list.

To review captured images:

Click the thumbnail next to the shot in the capture list to display the image.

To replace, retake, or delete a radiograph:

Icons for replacing, retaking, or deleting images appear to the right of the thumbnail after you capture
an image.
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l Click Retake to take an additional image of the same shot.
l Click Replace to take a new image of the same shot, replacing the previous one.
l ClickDelete to remove the image.

Pausing a Study

Tip: By default, a paused study closes after 4 hours, but you can change this value. To change this
setting, see "Setting the Duration of Paused Studies" on page 92.

To pause and then resume a study:

1. Click in the lower right corner of the Image Capture window.

The Home window is redisplayed.

2. To resume a paused study, select the paused request from the Pending list in the Home window .

When the study reopens, the first of the remaining shots is highlighted for capture. The shots you
capture now will be saved in the same study as those already captured.

Deleting Pending Image Requests

l Depending on your practice management system, you may be able to delete individual image
requests from the Pending list. To delete a single request, click the X on the right side of the request
row.

l If the IDEXX-PACS software is integrated with your Cornerstone or AVImark software, you can also
clear the entire Pending List. This option does not apply to Modality Work List requests.

1. Click theClear List button at the top of the Pending tab. This will remove all patient names from the
Pending tab.

2. Click Yes in the confirmation message.

Remember: This deletes the requests from IDEXX-PACS, but you will also need to delete the
requests from the Cornerstone or AVImark Software.

Checking and Approving Images

Before you click Done to save captured images, review them in the Image Viewer for content and
quality.
Consider the following:

l Is the area of interest positioned correctly in the image?
l Is the image oriented properly?
l Is the image of diagnostic quality?

As you assess the image, you can also:

l View the image full screen.
l Edit image details, such as study name.
l Reprocess the image.
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See the sections below for more information.
To learn more about the Image Viewer window, see "Using the Image Viewer Window" on page 33.

Positioning and Cropping the Area of Interest

To position (pan) the image:

Click the image in the Image Viewer, and then hold down the left mouse button as you drag the image to
the desired location. (Touch screen: press and drag with one finger.)

To crop the image:

1. Click theCrop tool , and then hold down the left mouse button as you drag the mouse to draw a
border around the area to keep. (Touch screen: press and drag with one finger.)

2. To adjust the crop border, click and drag an edge of the rectangle, or to rotate the crop border, click
and drag one of the corners.

For example, if the patient and the image detector/cassette were not aligned, collimation might
produce an irregular white area. You can rotate the crop border until the white area is excluded, and
then apply the crop.

3. When ready to crop, clickCrop near the corner of the cropped area. The area within the border
fills the window.

Tip: After you capture an image, a crop border is automatically applied around the image to remove
most of the unexposed plate area. You can rotate or adjust the border as needed before applying
the crop.

Changing Image Orientation

Orientation rules (also called hanging rules) are applied automatically to orient the image correctly for
each shot, but you can rotate or flip an image as needed.
Note: After an image is rotated, a marker shows the number of degrees clockwise the image has been
rotated; an "X!" marker indicates an image has been flipped horizontally; and a “Y!” marker indicates an
image has been flipped vertically. These markers are always displayed with the image and cannot be
hidden.

To rotate or flip an image:

Click the Rotate and Flip tool , and then select the option you want:

Rotate 90° clockwise

Rotate 90° counterclockwise

Flip top to bottom

Flip left to right

Assessing Image Quality

Use the tools below to examine an image before you end the capture session.
For information about other image enhancement tools, see Using Image Viewer Tools"Using Image
Viewer Tools" on page 35.
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Zoom

Displays the zoom tools. You can adjust magnification any of these ways:
—Click the Fit to Window button to see the entire image within the window.
—Click a predefined percentage.
—Click the plus or minus buttons to adjust size by 10% up or down.

Invert
Reverses light and dark values.

Window/Level
Displays contrast/brightness controls:
—Drag the upper scale left or right to change the level (brightness).
—Drag the lower scale left or right to change window (contrast).
Numerical values are displayed on the right side of the scales.

Reprocess:
Returns the radiograph to its original appearance and then applies new edge
enhancement. Previous changes or enhancements are removed. For more
information, see "Reprocessing images" on page 26.

Viewing the Image Full Screen

To review an image full screen:

Click the small arrow on the right edge of the image to expand the image window to the full width of the
screen. To restore the default view, click the arrow again.

Editing Image Details

Image details include series title, modality, and technique settings.
Note: The image details feature should be used only in a manner consistent with local laws governing
the maintenance of veterinary records used for diagnostic purposes.

To review and edit image details:

1. With the image open in the Image Viewer, click the study name above the image and hold down the
mouse button as you pull down the study panel. (Touch screen: press the name and pull down.)

2. Edit the following, as needed:
l Series title and comments
Note: The study title cannot be edited; it can be changed only on the shot selection window
before image capture.

l Image title
l Capture date, source, technician name, veterinarian name, andmodality
Note: The ability to change the capture date is provided so you can enter the correct date for
scanned documents.

3. Edit the following technique details, as needed:
l Distance—The distance from the x-ray source to the detector or screen; select the unit of
measure from the drop-down list.

l Thickness—The thickness of the body part in centimeters.
l Sedation—Select from the drop-down list.
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l Exposure mAs—The amount of x-ray exposure in milliampere-seconds (mAs). This is
calculated automatically if you enter values in the Exposure mA (current in milliamperes) and
Exposure Time (duration in seconds) text boxes.

l Exposure kVp—The amount of voltage (peak kilovoltage) used for this image.
l Use of Grid—Select this check box if a grid was used.

4. When finished, pull the bottom of the panel back up to close it.
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Retaking, replacing, or deleting radiographs

To retake a radiograph (take an additional shot of the same exam type):

1. In the capture list, select the thumbnail of the image you want to retake.

2. Click the Retake icon to the right of the thumbnail.
3. Capture the new image. A thumbnail for the additional image is added to the series.

To replace a radiograph (substitute a new shot for an existing one):

1. In the capture list, click the thumbnail of the image you want to replace.

2. Click the Replace icon to the right of the thumbnail.
3. Capture the image. A thumbnail for the new image replaces the original thumbnail.

To delete a radiograph:

1. In the capture list, click the thumbnail of the image you want to delete.

2. Click theDelete icon to the right of the thumbnail. The image is removed from the series.

Note: After you clickDone to finish the capture session, only an administrator can delete images.

Reprocessing images

Reprocessing returns the image to its original state. You can then apply new or different edge
enhancement values. Most of the time, you will not need to reprocess images.
IMPORTANT: Reprocessing removes any changes to the image, such as rotation, window/level
adjustments, and annotations.
You might want to reprocess an image if:

l You want to delete all enhancements and adjustments.
l The image was captured using the wrong exam type (for example, the shot type was skull, but the
animal’s abdomen was radiographed).

l The animal has a metal implant, and edges next to the implant appear dark or hazy.

To reprocess an image with ClearCapture Dx Image Processing:

ClearCapture Dx* Image Processing Technology provides advanced image processing in most IDEXX
DR systems, with the exception of some older IDEXX-DR 1417 systems. If you have an older IDEXX-DR
1417 system without ClearCapture Dx Imaging Processing, see the instructions in the section after this
one.
To reprocess the image with ClearCapture Dx Image Processing:

1. Click Reprocess .
2. From the Body Part drop-down list, select large-scale processing parameters for a particular body
part. Most of the time, you will not want to change this setting.

3. Use the Preset drop-downmenu to select one of the finer-level processing presets (soft, medium,
enhanced, or strong) for the selected body part. The preset adjusts the amount of edge detail in the
radiograph.

4. Click Apply. The image is displayed with the new edge enhancement applied.
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To reprocess an image without ClearCapture DX Image Processing:

1. With the image open in the Image Viewer, click Reprocess .
2. Type new values for Level (level refers to the size of the structure that is to be enhanced):

l Lower numbers (1–2) sharpen the edges on fine details such as bone texture.
l Higher numbers (4–5) sharpen the edges of organs, bones, and other larger structures.

3. Type a new value for Strength (strength tells the system howmuch to sharpen):
l A high number (greater than 50) sharpens strongly, but will showmore noise in other parts of the
image.

4. Click Apply. The image is restored with the new edge enhancement settings applied.

Apply enhanced image processing to abdominal, cardiac, and orthopedic images using the
Enhanced Contrast tool

Users of the ImageVue DR30 or ImageVue DR50 systems with IDEXX-PACS Imaging Software can
use the Enhanced Contrast tool to create a duplicate image that is processed specifically for
abdominal, cardiac, or orthopedic views.
To apply enhanced image processing:

1. Capture the radiograph (but do not clickDone).

2. Next to the image thumbnail, click Enhanced Contrast , and then select Abdominal,Cardiac,
orOrthopedic from the drop-downmenu. A new thumbnail for the reprocessed image is added to
the shot list.

3. Select the new thumbnail to see the enhanced image. Tip: To delete the enhanced image, click

Delete to the right of the thumbnail.

4. When finished, click to save the original and the enhanced image (if not deleted). If you
subscribe to IDEXXWeb PACS, both images will be uploaded to the cloud.

5. To compare the images side by side, reopen the study from the Home window, and then use the

Compare tool in the Image Viewer.
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IDEXX Diagnostic Imaging software offers advanced tools that let you:

l Use either a visual shot tree or a text list to select shots.
l Create your own lists of favorite shots.
l Add, delete, and retake shots.
l Use special shot options, such as a timed series of shots.
l Get real-time technique assistance to help you capture the best possible radiographs.
l Addmarkers to images to indicate image position or handle location (for portable plates).
l Use a DICOM®modality worklist to fulfill image requests started at your practice
management system.

Using Special Shot Options

Special shots are available for certain body regions. For example, if you select an abdomen shot
in the Add Shots window, you can choose a timed series of shots for an excretory urogram.

For a list of all available special shots:

In the IDEXX-PACS Home window, go to Settings > Exam Trees> Shot Options.

To select special shot options:

1. Start the image capture request.
2. In the Add Shots window, select the shot for the appropriate body part.
3. In the capture list, click the shot you want to add the options to.
4. Click the Add Options tab above the capture list.

A list of options appropriate for that shot is displayed.

5. Select an option.

The special shots are added to the capture list.

6. ClickOK to close the options list.
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Tips:

l An on-screen keypad is displayed if you click a box that requires numeric values, such

as a time period. Use the key to move to the next value, the key to back space,

and the key to close the keypad.
l When capturing a timed series, remember to pause the capture session and return to it
when it’s time to capture the next set of images. A timed series must be completed
within 24 hours. For more information, see "Pausing a Study" on page 22.

l All images within a timed series are stored within the same image study.

Creating and Using a Favorite Shots List

A favorite shots list is a custom list of shots you can create for easy access. Lists are displayed as tabs
on the Add Shots window. The software includes default favorite shots lists ready to use.

To create a favorite shots list:

1. Start the image capture process for any patient (you don’t have to capture the images unless you
want to).

2. In the Add Shots window, select the shots to include in the favorite shots list, and then clickDone.

3. In the Capture widow, click Favorites above the capture list.
4. Enter a name for the favorite shots list and click Save.
5. ClickDone to close the Capture window. A tab for the new favorite shots list will be added to the
Add Shots window.

To use a favorite shots list:

1. In the Add Shots window, select the tab for the list you want to use.
2. Add any additional shots or shot options as you normally would.

To update a favorite shots list:

1. Start the image capture process for any patient (you won't need to capture the images).
2. In the Add Shots window, select the favorite shots list you want to update.
3. Add or delete shots as needed.

4. When finished, from the Tools menu, selectCreate New Favorite.
5. Click Yes to overwrite the existing favorite shots list.

Tip: To save this list as a new list, clickNo, enter a new list name, and click Save.

Using Image Coach* and Other Technique Assistance

Image Coach* features available on the Image Capture window include: 29
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l The real-time positioning aid—a photo showing an animal correctly positioned for the shot
l Reference radiograph—an example radiograph showing the animal correctly positioned for the
shot

l Exposure index—a scale indicating the level of x-ray exposure

In addition, the IDEXX-PACS* technique prompt displays recommended kVp, mAs, and exposure
length.

Using the Real-Time Positioning Aid

Before you take a radiograph, you can review a photograph of a correctly positioned animal, along with
hints for achieving the position.

To display the positioning aid:

On the right side of the Image Capture window, click to display the photograph.
Next to the photo is a text description, along with recommended beam center, measurement point, and
other variables, as well as hints for obtaining the best quality radiograph.

Using Reference Radiographs

Before you take a radiograph, you can review a reference radiograph that shows how the radiograph
should look when the patient is positioned properly for this view.

To display a reference radiograph before you capture:

On the right side of the Image Capture window, click Reference. An example radiograph is displayed
for the selected view.
IMPORTANT: This radiograph is provided to assist in taking the radiograph correctly. It is not an
example of any particular pathology.

Using the Exposure Index

After you capture a radiograph, a scale on the Image Capture window displays the level of x-ray
exposure. This index shows whether the right amount of x-rays reached the detector or screen.
Remember:

l Trust the image. If the radiograph is of diagnostic quality, don't worry about an exposure index that
is a little high or low. The Normal area on the index is not an absolute goal.

l Use the exposure index to troubleshoot nondiagnostic radiographs. For example, if you have an
all-white or all-black image, a high- or low-exposure index is valuable information to share with
IDEXX Diagnostic Imaging Customer Support.

l The exposure index is relative—it is calculated differently for each shot.
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For nondiagnostic radiographs with low exposure index (underexposed):

Low exposure can cause graininess, a mottled appearance, or large amounts of visual noise.
Try the following:

1. Check that you measured the thickness of the anatomy correctly.
2. Check that you used the proper technique for this anatomy thickness and view and that you
selected the correct shot.

3. Increase your mAs by one generator setting.
4. Retake the same radiograph.
5. If the new radiograph is not diagnostic, call IDEXX Diagnostic Imaging Customer Support at
1-877-433-9948.

For nondiagnostic radiographs with high exposure index (overexposed):

Overexposed images generally appear too dark. Because digital images can be adjusted to many
different appearances, an overexposed imagemay look light in some areas and dark in others.
Try the following:

1. Check that you measured the thickness of the anatomy correctly.
2. Check that you used the proper technique for this anatomy thickness and view.
3. Decrease the kVp by 5–10, or decrease the mAs by two generator settings.
4. Retake the same radiograph.
5. If the new radiograph is not diagnostic, call IDEXX Diagnostic Imaging Customer Support at
1-877-433-9948.

If a particular exam type is always nondiagnostic and index is always high or low:

Contact IDEXX Diagnostic Imaging Customer Support about adjusting your technique chart for that
view.

If radiographs are always nondiagnostic and index is always high or low:

Ask your generator service technician about getting the generator calibrated. After generator
recalibration, contact IDEXX Diagnostic Imaging Customer Support to have a new technique chart
created.

Using the Technique Prompt

If you have enabled the technique prompt feature, you can review the recommended technique settings
(kVp, mAs, and seconds) for each shot before you capture the image.
To enable the feature, see "Setting Up the Technique Prompt" on page 88.

To review the suggested technique:

On the right side of the Image Capture window, select the weight of the patient or the thickness of the
body part to be radiographed. The kVp, mAs, and seconds values for that view appear in large numbers
above the weight/thickness selection area.
Note:

l For a DR system, your technique chart may be set up by weight or thickness, depending on the
system. Contact IDEXX Diagnostic Imaging Customer Support at 1-877-433-9948 if you have
questions.
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l For a CR system, the chart is set up by thickness. The technique prompt is not available for IDEXX-
CR 1417 systems that do not have ClearCapture Dx* software installed

Applying Image Markers

Adding a Position Marker

You can add amarker to a radiograph to indicate whether the image is left, right, lateral, or medial.
The marker becomes a permanent part of the image and will be flipped and rotated whenever you flip or
rotate the image.

To add a position marker:

1. After you capture an image, click in the toolbar below the image.
2. Select a marker type:

l L for either lateral or left
l M for medial
l R for right

Note: The D and Gmarker types support markers in other languages.

3. An "X" appears in all four corners of the image; click the X in the corner where you want the marker to
appear.

Note: You can change the marker by repeating these steps. But once you leave the Image Capture
window, the marker is fixed. You cannot move the marker to a different location or remove it from the
image.

Setting Up the Plate Handle Locator

If you are using an IDEXX-DR* 1417 system, you can add a plate handle locator to your images to
indicate plate orientation.

To add the plate handle locator:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickGlobal Settings.
3. Select the Show Plate Handle Locator check box.
4. Click Save to save and close the window, or click Apply to save without closing.
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Capture
The Image Viewer is the work space where you can review, enhance, and annotate images, as
described in the sections below, and where you can share images in various ways.
See these chapters for more information:

l "Managing Images" on page 50
l "Importing and Distributing Images" on page 59
l "Managing Client and Patient Records" on page 71

Using the Image Viewer Window

When you capture a new image or open a previously captured image, the image is displayed in
the Image Viewer. In this window you can:

l View the image full screen.
l View and edit image information.
l View patient information.
l Select and review images from the patient’s radiographic history.
l Annotate and enhance images using reviewing tools.

To review an image full screen:

Click the arrow on the right edge of the image. Click again to redisplay the patient history.

To review and edit image information:

Click the study name above the image, and then pull the cursor down. (Touch screen: touch and
pull down.) You can edit these image details. For more information, see "Editing Image Details"
on page 50.
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Image Viewer with study panel pulled down

To review patient information:

Click the patient name above the patient history area on the right, and then pull the cursor down. (Touch
screen: touch and pull down.)

l The patient ID is next to the patient name. IDs generated by IDEXX-PACS are in parentheses
(1234). IDs generated by your practice information management system (PIMS) are in square
brackets [1234].

l If you see [Add ID] in place of a patient ID, IDEXX-PACS could not find a PIMS patient ID for this
patient. Click Add ID to open the Patient/Client Management window and enter a patient ID.

You cannot edit any other patient information here. To edit patient information, click Tools , and then
select Patient/Client Management. For more information, see "Updating a Patient or Client Record" on
page 72

Image Viewer with patient panel pulled down

To select and review images from the patient history:

1. On the right side of the Image Viewer, find the study date you want, and then click the down-arrow to
open the study.

2. Click a thumbnail to review the image.

Tip: You can also compare images for this patient. For more information, see "Comparing Images"
on page 46

To use reviewing and enhancement tools:

1. Click a tool in the toolbar located below the image.
2. For information about each tool, see Using Image Viewer Tools.

Saving Modified Images

To save modified images in the database:

With the modified image open in the Image Viewer, clickHome , and then click Yeswhen prompted
to save the image.
Tips:

l
Do not use the Save button at the bottom of the Image Viewer to save images in the database.
Use the Save button only when you want to save images outside of the database, such as in a
personal folder, on a CD, or on another computer.
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l If you need to restore the image to its original appearance, open the image in the Image Viewer and

click the Restore Original tool. All changes are removed, and the image is restored to its
original appearance at time of capture.

Using Image Viewer Tools

The toolbar at the bottom of the Image Viewer lets you review, enhance, and annotate your images.

IMPORTANT: Each image can have only one enhanced version. If you make changes to the enhanced
version, the previous image is overwritten. However, the original image is never overwritten. You can

always use the Restore Original tool to return to the version you saved at the end of the capture
process.

To use an Image Viewer tool:

1. Click the tool icon; if a palette of tools opens, select the one you want. Refer to the individual tool
descriptions below to learn more.

2. When finished, click the tool again to close it.

Annotation Tools

Click the Annotation tool to display a palette of line, shape, and text tools. Select the
one you want and then click and drag the mouse pointer on the image to complete a
line or shape.
Click the Annotation tool again to close it.

Pointer draws an arrow.

Line draws a straight line.

Rectangl draws a square or rectangle.

Freehand draws a freehand line.

Ellipse draws a a circle or oval.

Text displays a box where you can enter text. To move the text, click and drag the text
box to a new location.
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To change or delete an annotation:

1. Click the Annotation tool, and then click the annotation on the image. Editing options are displayed.

2. Update the annotation, or click to delete it.
3. Click the Annotation tool again to close it.

To hide or show annotations:

Click the Toggle tool on the main Image Viewer toolbar.

Measurement Tools

Click theMeasurement tool to display a palette of tools for calibrating images and for measuring lines,
structures, and angles, as described below.

For instructions on calibrating images, see "Calibrating Images" on page 42.

For instructions on using the Norberg angle tool for measuring hip dysplasia, see
"Calculating the Norberg Angle" on page 42.

For instructions on using the TPLO (Tibial Plateau Leveling Osteotomy) tool for surgical
planning, see "Calculating the TPLO Angle" on page 43.

For instructions on using the VHS (Vertebral Heart Score) tool for measuring cardiac
enlargement, see "Calculating the Vertebral Heart Score" on page 43.

Click the Protractor tool, and then click the image and drag to draw a line to the corner
of the angle. Release the mouse button, and then click again to place the endpoint of the
second line. The angle measurement between the two lines is displayed.

Click the Ruler tool, and then click and drag to draw ameasurement line on the image.
Note: The Ruler tool is accurate only if the system or the image has been calibrated.
Otherwise, a window opens so you can begin the calibration process. For more
information, see "Calibrating Images" on page 42.

Click the Image Rulers tool to display or hide an image ruler along the top and left side
of the Image Viewer. A marker on each ruler shows the current position of the mouse
pointer or imaging tool within the image.
Note: The Image Ruler is accurate only if the system or the image has been calibrated.
Otherwise, a window opens so you can begin the calibration process. For more
information, see "Calibrating Images" on page 42.
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Crop Tool

Click theCrop tool and then click and drag a crop border on the
image around the area you want to keep. Right-click inside the border
and select Apply Crop. (Touch screen: touch and hold with one
finger and then tap with another finger to display the menu.)

Tip: To adjust the border, click and drag an edge of the rectangle. To
rotate the crop area, click and drag one of the corners. For example,
if the patient and the image detector/cassette were not aligned and
collimation produced an irregular white area, you could rotate the
crop area to exclude the white area from the image.

Actual Size Tool

Click the Actual Size tool to display the image at approximately life size.
Because monitors can vary slightly, the correlation may not be exact.
Note: Youmust calibrate the software before using the Actual Size tool. For
more information, see "Calibrating Images" on page 42.
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Magnify Tools

Click theMagnify tool to open a palette of tools for changing image size, as described
below.

Click the Fit to Window tool to enlarge the image to fill the Image Viewer.

Click theMinus tool to reduce image size by 10%.

Click a value to display the image at the specified percentage.

Click the Plus tool to increase image size by 10% with each click.

Click theMagnifier tool, and then click the image to magnify the specific area.
As you move the tool, the magnified area moves. When the tool stops, a scale
appears at the bottom of the magnified area. Move the slider on the scale to
increase or decrease magnification.

To change the window and level (contrast and brightness) within the magnified
area, select the Lock Window check box and then click and drag the mouse
pointer within the magnified area. When finished, clear the check box to
continue using the Magnify tool, or click theMagnifier tool again to deactivate
the magnifier.

Contrast and Brightness (Window/Level) Tool

Click theContrast and Brightness tool to display slider bars you can use to
adjust these values.

Drag the Level slider bar to adjust image brightness.

Drag theWindow slider bar to adjust image contrast.

For more information about image contrast and brightness and when to adjust these values, see "When
to Adjust Contrast and Brightness (Window/Level)" on page 41.

38



Viewing and Enhancing Images after Capture

Invert Tool

Click the Invert tool to invert the colors in your image. White becomes black,
and black becomes white.

Rotate and Flip Tools

Click the Rotate and Flip tool to display a palette of tools to change image
orientation.
Markers are automatically added to the image to indicate that orientation has
changed. The markers are displayed with the image and cannot be hidden.
If the images includes annotations, the annotations rotate or flip, as well

Click once to rotate the image 90° clockwise. A marker shows the number of
degrees or rotation.

Click once to rotate the image 90° counterclockwise. A marker shows the
number of degrees or rotation.

Click once to flip the image top to bottom. An "X!" marker is added to the flipped
image.

Click once to flip the image left to right. A "Y!" marker is added to the flipped
image.

Restore Original Tool

Click the Restore Original tool to return the image to the way it
looked when you opened the Image Viewer. All modifications to the
image will be lost.

Reprocess Tool

For more information about reprocessing, see "Reprocessing images" on page 26.

Click the Reprocess tool to return the image to its original state and then apply
new edge enhancement values. Reprocessing removes any changes you
made to the image, such as contrast and brightness adjustments and
annotations.
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Toggle Overlays and Annotations Tool

Click the Toggle Overlays and Annotations tool to show or hide the overlays
and annotations on the image.

Left-Right Marker Tool

Click the Left-Right Marker tool to place a left-right marker on the image. For
more information, see "Adding a Position Marker " on page 32.

Editing and Applying Image Overlays

An overlay displays information about the image, such as patient name, date of birth, and image and
series name, in the corners of the image. You can choose which information to include in the overlays.
Tip: You can also choose to include the overlay information whenever you export an image. For more
information, see "Setting Up Imaging Units, Compression, and Export Options" on page 88.

To review or hide the image overlay:

With an image open in the Image Viewer, click .

To select overlay content:

1. With an image open in the Image Viewer, go to Tools > Edit Overlay.
2. In the overlay window, select the check boxes for the information you want to include.
3. For each selected item:

l In theGrouping column, select the corner where the information should be displayed.
l If multiple information items are in the same corner, use theOrder and Line Number columns
to specify the order of the information and the lines on which it is displayed.

4. ClickOK.

Image Overlays and DICOM

If you create a DICOM file of an image, the DICOM header holds much of the same information that is
displayed in the overlays. For this reason, the ability to apply overlays is not available whenever you:

l Email an image as a DICOM file
l Send an image via DICOM
l Save an image in the DICOM (DCM) format using the Save As feature
l Send a telemedicine case using DICOM
l Create a Patient CD†
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By default, the IDEXX-PACS software sends the original version of the radiograph, as it looked when
you clicked Done at the end of the capture process (or when you imported or received the file).
Changes made to the image later are not part of the DICOM image. To send the current version of the
DICOM image rather than the original version, contact IDEXX Diagnostic Imaging Customer Support at
1-877-433-9948.
†Although a DICOM image cannot have annotations or overlays, the JPEG version of the same image
can have them if you choose. When you display a DICOM image using the viewer that is included on a
Patient CD, information from the DICOM header is displayed the same way the overlays are displayed
within the IDEXX-PACS software.

When to Adjust Contrast and Brightness (Window/Level)

TheWindow/Level tool opens two scales you can use to adjust image contrast and brightness.

During initial processing, the software uses parameters defined by exam type to create a default look.
You may need to adjust the look because of differences in collimation and variations in exposure and
size.

l Window indicates howmuch contrast is in the image.

A small window (500–2,000) creates high contrast, but some bone or lung detail may be "washed
out." A very large window (around 5,000 or 10,000), causes the image to be flat and very evenly
gray. The most frequent use of window is to adjust the contrast down to provide a high-contrast
image.

l Level sets the center point where the image changes from white to black, similar to the brightness
adjustment on a TV. Changing the level makes the overall image lighter or darker and allows you to
see detail in different areas. For most images, the level will average around 8,000.

The most frequent use of level is to adjust brightness to review different areas, for example, to
review the lungs and the abdomen in the same image.

To use the Window/Level tool:

Click the Window/Level tool, and then:

l

Drag the upper scale left or right to change the level (brightness).

l

Drag the lower scale left or right to change window (contrast).

Numerical values are displayed on the right side of the scales.

To adjust window/level without using the tool:

Make sure imaging shortcuts are enabled, and then:

l Click and drag the cursor left or right to decrease or increase the window.
l Click and drag the cursor up or down to decrease or increase the level.
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Special Measurement and Planning Tools

Calibrating Images

The Calibration tool lets you review an image at actual size andmeasure structures within the image.
IMPORTANT: To calibrate, you must know the exact size of a feature within an image to use as a
standard of measurement.
The Calibration tool is most useful in small animal radiography, where the distance between the x-ray
source and the x-ray detector is usually fixed.

Before you begin:

In the specify the units of measure you want to use (English or metric). For more information, see
"Setting Display Formats" on page 83.

To calibrate images:

1. Open an image that has a feature for which you know the exact measurement.

2. Click theMeasurement tool , and then click theCalibrate tool .
3. Click and drag to draw a line on the image that corresponds to the feature for which you know the
exact measurement.

The Calibration Settings window opens.

4. In the Length box, type the number of units (inches, centimeters, etc.) that matches the length of the
feature in the image.

5. ClickOK. The window closes and the Calibrated value in the image overlay reads “Calibrated: true.”
6. Close the Image Viewer and then reopen it. The new calibration setting takes effect when you
reopen the Image Viewer.

You can now use the Ruler tool to measure other structures on this image or on other images of
the samemodality.
Note: This calibration setting is applied to all radiographs captured with this modality. If the source-to-
plate distance changes, you must recalibrate by repeating the steps above.

Calculating the Norberg Angle

The Norberg angle tool is used to assess hip dysplasia and hip laxity. Follow the instructions below to
place the Norberg angle template on the image, and then adjust the template to determine the Norberg
angle.

To calculate the Norberg angle:

1. Click theMeasurement tool , and then click theNorberg tool.
2. Place the mouse pointer in the center of one femoral head and click.
3. Place the mouse pointer in the center of the second femoral head and click.

The Norberg angle template is displayed, with the default Norberg angles for each hip (0°) shown
near the femoral head circles and the default combined Norberg angle value shown in the center.

4. Adjust the Norberg angle template by doing the following:
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l Tomove the entire template, click the solid lines anywhere outside of the circles and
drag.

l To change the angle of one of the femoral-head-to-rim-of-acetabulum lines, click and
drag the small square handle. This handle is on the line near the circle.

l Tomove a circle, click the center point and drag.
l To adjust the size of a circle around the center point, click the small round handle and
drag.

l To adjust the size of a circle relative to a fixed edge point, click the small round handle
and drag it to the point on the circle that you want to be fixed in place. Then click
elsewhere on the circle to create a second handle, and drag this handle.

Note: If you add a third handle, the circle is redrawn so that it passes through all three
handle points. The circle is adjusted as you click and drag any of the handles.

l To adjust a circle for the best fit to an irregular area, such as a deformed femoral head,
click to add points along the edge of the femoral head. The software redraws the circle
to be the closest possible fit to the points andmoves the center point appropriately.
You can have up to 10 points around the circle.

Calculating the TPLO Angle

The TPLO tool lets you place the tibial plateau leveling osteotomy (TPLO) template on an image, and
then adjust the template to determine the TPLO angle.
The TPLO template is a set of three lines which intersect at a common point:

l Line 1 is vertical when the template is first displayed. This is the line that should be aligned with the
length of the bone so that it passes through the center of the talus and through the centers of the
intercondylar eminences of the tibia.

l Line 2 is always perpendicular to line 1. When you move or rotate line 1, line 2 moves and rotates
with it.

l Line 3 is the line that you move to calculate the TPLO angle, which is measured between lines 2 and
3. As you rotate line 3, the TPLO angle measurement changes.

To determine the TPLO angle:

1. Click theMeasurement tool , and then click the TPLO tool.

2. Click on the image at a point as close as possible to where you want the center point of the template
to be.

This limits the number of line adjustments you need to make to move the template into place.

3. Adjust line 1 (the vertical line): Click on the blue or green handle and drag to rotate the line around
the center point, or click anywhere on the line and drag to move the line.

Line 1 must align with the length of the bone and pass through the center of the talus and through
the centers of the intercondylar eminences of the tibia.

4. Move line 3 to calculate the TPLO angle: Click on the red or green handle and drag to rotate the line
around the center point, or click anywhere on the line and drag to move the line.

Calculating the Vertebral Heart Score

The vertebral heart score (VHS) tool is used to determine whether the heart is enlarged.
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The VHS is determined by measuring the length and width of the heart and then comparing these
measurements to a section of the thoracic vertebrae. Essentially, you measure howmany vertebrae
long the heart is and howmany vertebrae wide. The sum of the twomeasurements is the VHS.
The IDEXX-PACS* software calculates the VHS using three measurements on a thoracic lateral
radiograph:

l The length of the heart from the cranioventral border of the carina to the cardiac apex.
l The width of the heart at the widest point on the cardiac image, measured using a line perpendicular
to the length line.

l The average length of five thoracic vertebrae, starting from the cranial edge of the T4 vertebra and
moving in a caudal direction. (You can change the number of vertebrae used to calculate this
average, as described below.)

When you’ve made these measurements, the VHS tool determines the length and width of the heart in
average vertebral units (to one decimal place). The sum of the length and width is the VHS.

To use the VHS tool to calculate vertebral heart score:

1. Open a thoracic lateral radiograph in the Image Viewer.

2. Click the Zoom tool , and then zoom in so that you can see the heart and the T4–T12 thoracic
vertebrae clearly. This will also make it easier to work with the lines.

3. Click theMeasurement tool , and then click the VHS tool. Two sets of lines and an annotation
window appear on the image:
l The pair of crossed lines is used to measure the heart. One line is labeled Short Axis and the
other is labeled Vertical Axis.

l The set of three parallel lines is used to measure the vertebrae. The lengths of the top and
bottom vertebral lines match the lengths of the heart lines and will change as the heart lines are
adjusted. The middle vertebral line is used to calculate the average vertebra length. By default,
the average vertebra length is based on five vertebrae (T4–T9); to change the number of
vertebrae used to calculate the average, see “To change VHS tool settings,” below.

When you first open the tool, the VHS value is shown as N/A. A numerical value is calculated and
displayed as you adjust the measurement lines.

VHS tool applied to an image
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4. Measure the long axis of the cardiac silhouette as follows:
a. Click one end of the Vertical Axis line andmove it to the carina of the mainstem bronchus.
b. Click the other end of the Vertical Axis line andmove it to the cardiac apex.

5. Measure the short axis of the cardiac silhouette, perpendicular to the vertical axis, as follows:
l Click one end of the Short Axis line andmove it to one side of the widest axis of the heart.
l Click the other end of the Short Axis line andmove it to the other side of the widest axis, keep the
line perpendicular to the Vertical Axis.

6. Adjust the vertebral measurement line (middle line of the three parallel lines), as follows:
a. Click one end of the middle line andmove it to the cranial edge of the T4 vertebra.
b. Click the other end of the middle line andmove it to the cranial edge of the T9 vertebra (or to a
different vertebra, if you have changed the tool settings). The VHS tool uses the length of this
line to calculate the average vertebral length.

7. Note the resulting VHS value displayed on screen and in the VHS annotation box.

Tips: To delete the VHS lines from the image, clickDelete in the VHS Annotation Settings window,
and then click theMeasurement tool to close it.

To change VHS tool settings:

With the radiograph open in the Image Viewer, open the VHS tool again, and click on any of the VHS
lines on the image. The VHS Annotation Settings window opens. Change settings as follows:

l To change the number of vertebrae used to calculate the average vertebra length, type a new
number in theNo. of Vertebrae text box, and then drag the middle measurement line to the
appropriate vertebra.

l To override the calculated VHS value, type a new value in the VHS Annotation Settings window, and
then click the image to close the window and apply the new value.

l To recalculate the value, delete the current value. Click the image to close the window. The VHS
value is recalculated using the current line settings.

l To change the color, width, or style of any of the lines, select the appropriate tab in the VHS
Annotation Settings window, choose the desired values, and then click the image to close the
window and apply the new values.

Using Surgical Templates

Surgical templates are not included in the IDEXX-PACS software, but if you have separate surgical
template software installed, the Surgical Template tool is available in the Image Viewer.
This tool allows you to launch the independent software so that you can add templates to a copy of an
IDEXX-PACS software image for presurgical evaluation. You can drag and place templates of
orthopedic implants onto an image andmake surgical measurements.

To use surgical template software on an IDEXX-PACS software image:

1. Open the image in the Image Viewer and then click the Surgical Templates tool .

The surgical template software opens in a new window. The image you were reviewing opens in the
surgical template window.

2. Use the surgical template software to apply templates to the image for presurgical planning. Refer
to the surgical template software user instructions for more detail.
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3. After you have applied the templates, bring the template-modified images back into the IDEXX-
PACS software. For more information, see "Bringing a Template-Modified Image Back into the
IDEXX-PACS Software" on page 68.

Comparing Images

l You can compare up to four images.
l You can compare images of different formats (e.g., DICOMwith JPG).
l All images being compared must belong to the same patient.
l If your IDEXX-PACS software is integrated with your Cornerstone software, always use the IDEXX-
PACS software when comparing images for diagnostic purposes, even if the files are non-DICOM
images, such as JPGs.

To compare multiple images for the same patient:

1. Open the study, and then select the thumbnail of the first image you want to compare.

2. ClickCompare above the history panel on the right side of the window.
3. Select the thumbnails for the other images. The images open alongside the first image.
4. To close an image, select it in the main window and then click the X in the upper right corner; to stop

comparing, select the image you want to keep open, and click Single View .

Viewing Dental Radiographs

When you review dental radiographs, specialized dental reviewing modes are available on the Image
Viewer window. These modes allow you to arrange images in a variety of dental layouts and to move
back and forth among them.
There are three modes:
• Template layout mode
• Review all images mode (all the images from the template layout are displayed in a grid)
• Review selected images mode (selected images are reviewed in isolation, at a larger size)
Note:Dental image reviewing modes are available only if you have selected Intra-oral Radiography (IO)
as the imagemodality. For more information, see "Labeling a Radiograph as Intra-Oral" on page 46.

Labeling a Radiograph as Intra-Oral

To review dental radiographs in a dental template, you must first label the radiographs as intra-oral.

To label a radiograph as intra-oral:

1. With a dental radiograph open in the Image Viewer, click the study name above the currently
displayed dental image and pull down to reveal the study panel.

2. In theModality box (in about the middle of the panel), click the down-arrow and select Intra-oral
Radiography.

3. Drag the bottom of the panel up to close the panel.
4. Repeat for each radiograph in the study.

5. ClickHome .
6. When prompted to save each image, click Yes.

The next time you open the study, the radiographs appear in the dental template. You can select a
different dental template if needed.
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Using Dental Template Mode

In dental template mode, the primary radiographs in the dental series are displayed in the template
pane and are arranged in a template layout so you can review them together. The rest of the images are
in the overflow pane at the bottom of the window.
The radiographs are placed in cells that are shown as black rectangles. You can move a radiograph
from one cell to another, either within the same pane or between panes. If you move a radiograph to an
occupied cell, the radiograph currently in the cell moves to the last overflow cell in the overflow pane.
Note:Only images identified as Intra-Oral Radiography are displayed in dental templates. For more
information, see "Labeling a Radiograph as Intra-Oral" on page 46.

To display radiographs in a different template layout:

1. Click Templates in the Image Viewer toolbar. A menu displays layout choices.
2. If using a mouse, move the mouse pointer over the choices in the list to see representations of the
layouts.

3. Select one of the template layouts. The radiographs are displayed in that layout.

To place a radiograph in a different cell:

1. Click the image and drag it to the cell.
2. Release the mouse button when the cell turns white. The radiograph now occupies that cell.

Note: The radiograph that had occupied the cell is moved to the last overflow cell.

To remove a radiograph from the template layout:

Click the radiograph, drag it to the overflow pane, and release the mouse button.
Note: If you release the mouse button when the radiograph is between cells in the overflow pane (no
cell turns white), the radiograph you are moving is placed in the last overflow cell.

To save the current arrangement of radiographs for this series:

No action is necessary. The next time you open the series in the Image Viewer, the radiographs will be in
the same cells they were in when you closed the series.

Review Selected Images Mode and Review All Images Mode

Dental image reviewing modes are available only if you have selected Intra-oral Radiography (IO) as the
imagemodality. For more information, see "Labeling a Radiograph as Intra-Oral" on page 46.

To review one or more radiographs in Review Selected Images mode:

1. Click a dental image or hold down the CTRL key and click more than one image.

2. Click Review ,and then select Review Selected. The image or images are displayed in a
larger size.

Tip: You can also double-click a single image to review it in a larger size.

3. To redisplay the image(s) in the dental template, click Back to Series in the upper right corner of the
pane.
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To review radiographs in Review All Images mode:

1. Click Review , and then select Review All. All images that appeared in the template now
appear in a grid format.

2. To redisplay the image(s) in the dental template, click Back to Series in the upper right corner of the
pane.

Viewing Multimedia Files

You can reviewmultiframe DICOM files andmultimedia files, such as ultrasound images, CT scans, AVI
(.avi) files, and MPEG (.mpg, .mpeg) files in the IDEXX-PACS Image Viewer.

To review multimedia files and capture images from them:

1. Import the file to a patient record. For more information, see "Importing Non-DICOM Files" on page
67

The file opens in the Image Viewer with the multimedia toolbar displayed along the bottom.

A thumbnail image is added to the current study. An arrow icon on the thumbnail indicates this is a
video file.

2. Use these tools to review the file:

3. Click the slide bar to quickly move to a specific spot in the video.

To use full-screen mode:

1. When the multimedia player is in full screen mode, press the SPACEBAR to pause or play the
video.

2. Press ESC to return to the Image Viewer in normal mode.

To capture images from the video:

To capture a single frame of the video file, click theCapture button in the video toolbar.
Each captured frame is saved as a still image, with a thumbnail in the current study. You can annotate
the still images as needed.

Viewing CardioPet* ECG Files

You can review DICOM* ECG files in the Image Viewer, as long as they were recorded using an IDEXX

CardioPet ECGDevice. DICOM* ECG files are identified by a heart icon in the patient card and in
the history panel of the Image Viewer.

48



Viewing and Enhancing Images after Capture

To review DICOM ECG files:

1. Click the heart icon on the patient card or within the history panel of the Image Viewer. The ECG
opens in a separate browser window.

2. Use the tools at the top of the window to adjust the feed and gain and to hide or display the grid.
3. Use the scroll bar at the bottom of the window to scroll backward or forward through the ECG.

Note: The standard radiograph reviewing tools, the Compare tool, and the Clone tool are not available
for use with ECG files. However, you can use certain tools located below the history panel:
Import/Export, Reassign, Save, Print, and Delete.
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Reassigning a Study

Youmust assign a STAT study to a patient. You can also use the following steps to reassign any
existing study to a new or different patient.
Note: You can reassign entire studies only, not individual images.
IMPORTANT: If your IDEXX-PACS software is integrated with your Cornerstone software, always
reassign diagnostic images in the IDEXX-PACS software. This way the updated information will
be returned to Cornerstone, and the Cornerstone record will be updated accordingly.

To reassign a study:

1. Find and open the patient study, and then click Reassign in the bottom right tool bar of
the Image Viewer. The Reassign Images window opens.

Tip: If this is a STAT patient, you can also click the Reassign button at the top of the
STAT patient card in the Home window.

2. In the Reassign Images window, select the appropriate tab to assign the study to an existing
patient or to a new patient

3. If this is an existing patient, search for and select the patient; if this is a new patient, enter the
patient information.

4. Click Reassign.

A confirmation message displays the patient and client information for the reassigned study.
Note: A patient ID in square brackets is one generated by your practice information
management system.

5. ClickOK to close the message.

If your IDEXX-PACS software is integrated with Cornerstone software, the reassigned study is
removed from the current Cornerstone Patient Clipboard* and will be available in the Patient
Clipboard for the patient you assigned the study to.

Editing Image Details

Image details include series title, modality, and technique settings.
Note: The image details feature should be used only in a manner consistent with local laws
governing the maintenance of veterinary records used for diagnostic purposes.

To review and edit image details:

1. With the image open in the Image Viewer, click the study name above the image and hold
down the mouse button as you pull down the study panel. (Touch screen: press the name
and pull down.)

2. Edit the following, as needed:
l Series title and comments
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Note: The study title cannot be edited; it can be changed only on the shot selection window
before image capture.

l Image title
l Capture date, source, technician name, veterinarian name, andmodality
Note: The ability to change the capture date is provided so you can enter the correct date for
scanned documents.

3. Edit the following technique details, as needed:
l Distance—The distance from the x-ray source to the detector or screen; select the unit of
measure from the drop-down list.

l Thickness—The thickness of the body part in centimeters.
l Sedation—Select from the drop-down list.
l Exposure mAs—The amount of x-ray exposure in milliampere-seconds (mAs). This is
calculated automatically if you enter values in the Exposure mA (current in milliamperes) and
Exposure Time (duration in seconds) text boxes.

l Exposure kVp—The amount of voltage (peak kilovoltage) used for this image.
l Use of Grid—Select this check box if a grid was used.

4. When finished, pull the bottom of the panel back up to close it.

Saving an Image in a Different Format

After you click Done at the end of a capture session, all captured images are saved to the database.
However, you can also save images to your local computer or network in various file formats, so that the
images can be imported into other software programs or sent over the Internet.
Available formats:

l Bitmap
l JPEG
l JPEG 2000
l RAW
l TIFF
l DICOM
l Video (.avi, .mpg, .mpeg)

To save images in a different file format:

1. In the Home window, find the patient record for the study date; then in the patient card click ,

and then click .

OR

If the image is already open in the Image Viewer, click in the lower right area of the window.

The Sharing window opens. Thumbnails from the current study are at the top left.

2. Use the Sharing window to select the images you want to save. For more information, see "Using
the Sharing Window" on page 59.

3. When you have selected all the images, click .
4. Choose a location and enter a file name.

51



Managing Images

5. Select the format from the Files of Type drop-down list.
6. To include any annotations you applied in the Image Viewer, select Burn Annotations.
7. To include the overlay information displayed in the Image Viewer, select Burn Overlays.
8. Click Save.
9. ClickClose to close the Sharing window.

Cloning an Image

When you clone an image, you make a copy of the current version of the image, including any
annotations or enhancements.

To clone an image:

1. With the image open in the Image Viewer, click in the lower right corner of the window. A copy
of the image appears beside the original image. "(Copy)" is appended to the image name.

2. Modify or adjust the cloned image as needed.
3. To save the cloned image, click the X in the upper right corner of the image, and then click Yes
when prompted to save.

Deleting an Image

IMPORTANT:

l Only a system administrator can delete images. For more information, see "Creating a System
Administrator Account" on page 80.

l Only individual images can be deleted; you cannot delete series or studies. A series or study is
automatically deleted when all the images within it have been deleted.

To delete images:

1. Log on as the system administrator.
2. In the Home window, find the patient record containing the image to be deleted.
3. Click the thumbnail in the patient card to open the image in the Image Viewer.

4. In the lower right corner of the window, click .

You are prompted to confirm the deletion.

5. Click Yes to delete the image, orNo to keep the image.

Ensuring that Images Are Correctly Matched to Patients

If you notice that some images are associated with the wrong patients or that there are duplicate patient
records in the IDEXX-PACS software, your system configuration may have changed since installation,
and you may need to adjust your patient-matching settings.
Follow the steps below to review and adjust your settings as needed.

Check settings on your image-capture computer

Your image-capture computer should use patient IDs from your practice information management
system, if that system is integrated with IDEXX-PACS. These IDs are known as PIMS IDs.
Check these settings on the image-capture computer to ensure you are using the PIMS ID (if you have
an integrated system):
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l Check your Client and Patient settings. For integrated systems, choose the option to use patient IDs
from your practice information management system.

l Under Global Settings select the practice information management system that you use.Note:
Selecting the system name will also add a system identifier to each image (in the image DICOM
tags).

l Check your local DICOM server configuration. In the Image Import Settings area, make sure that
Patient ID is selected in the Patient Match Level drop-down list and that theUse PIMS Patient ID
option is selected at the bottom of the window.

Check image import settings on your IDEXX-PACS server

On your IDEXX-PACS server, check your local DICOM server configuration. In the Image Import
Settings area, the Patient Match Level drop-down list should display one of the following:

l Patient ID—if your IDEXX-PACS software is used onlywith IDEXX digital imaging systems (for
example, you do not import images from an ultrasound, a dental, or a non-IDEXX radiography
system).

l Patient Name, Sex, Species, DOB, Client Last Name—if your IDEXX-PACS software is used with
any non-IDEXX systems (such as an ultrasound, a dental, or a non-IDEXX radiography system). In
this case, also deselect theUse PIMS Patient ID check box at the bottom of the window.

Starting the image request

To avoid mismatched images, always begin the image request from your practice information
management system.
This is especially important if you use Cornerstone, AVImark, or ImproMed software. When you start an
image request from one of these systems, IDEXX-PACS assigns a unique ID (separate from the PIMS or
patient ID) to the requested study. That ID will be used to link the captured images to the image request,
ensuring that images are matched to the correct patient record, without relying on the patient ID or other
patient information.

Using the Radiology Log

Radiology log information is automatically recorded for each radiograph taken on your IDEXX
Diagnostic Imaging System.
You can record technique details during the capture process or when you are reviewing the images
later.
You can review the entire log, print it, email it, or export it as a PDF (Portable Document Format) file.

Viewing and Editing the Radiology Log

The radiology log captures information about each image. The information comes from the image's
study panel. For more information, see "Recording Technique Information in the Radiology Log " on
page 54.
You can also add information to the log directly, as described below.
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To review and edit the radiology log:

1. In the Home window, click Tools > Radiology Log....
2. Enter any combination of search criteria:

l Date range (use theCalendar button )
l Client or patient name or ID
l Technician name
l Modality

3. Click Search.
4. Scroll down to see all the results, and scroll to the right to see all the information for each image.
5. To sort the log, click the column header you want to sort by.
6. To add an entry to the log, click Add Entry, and then enter information in the new row at the top of
the table.

7. To edit information, click in the cell, and then enter or select a new value. You cannot edit patient
and client information.

8. To delete an entry you added, click in the row to select it, and then clickDelete Entry.

Note: You cannot delete entries created automatically by the IDEXX-PACS* software.

9. To print or share the log with others:
l Click Print Log, and then click the Print button in the upper left corner of the Preview window.
l Click Email Log, enter and address and a subject, and then click Send.
l Click Export as PDF, enter or select a location to save the PDF, and then click Save.

10. When finished, click Save and thenClose.

Recording Technique Information in the Radiology Log

You can enter technique details for an individual image in the image's study panel. The information is
then stored in the radiology log.

To record information in the radiology log:

1. With the image open in the Image Viewer window, pull down the study panel. For more information,
see "Editing Image Details" on page 50.

2. Enter or edit the following information to save it in the radiology log:
l Distance—Distance between generator and body part.
l Thickness—The thickness of the body part being imaged.
l Sedation—Select from the drop-downmenu.
l Exposure mAs—The amount of x-ray exposure in milliampere-seconds (mAs). This is
calculated automatically if you enter values in the Exposure mA and Exposure time boxes.

l Exposure mA—The amount of current in milliamperes (mA).
l Exposure Time—The duration of the exposure in seconds as a decimal value, or use the drop-
downmenu to select a fraction of a second.

l Exposure kVp—The amount of voltage (peak kilovoltage) used for this image.
l Use of Grid—Select the check box if a grid was used.
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Backing Up and Archiving Images

Be sure to back up your data frequently. IDEXX-PACS* Imaging Software offers several backup
options.
In addition, you may want to archive older images to save space on your computer. Archiving moves
images from the local computer to another location for long-term storage.
For more information about backing up and archiving, see the sections below.

Backing Up Your Data

IDEXX-PACS* software offers three backup options:

l Full—The IDEXX-PACS software stores the last 3 days of data. Data backups are stored in the
cloud (in the event of a system failure, contact IDEXX Diagnostic Imaging Customer support to
download data files to your server if needed).

Note: Backup folders are saved for 3 days only. After 3 days, the next backup will overwrite the
oldest of the 3 folders. In addition, multiple backups in a single day overwrite any other backups
made the same day. To keep images and data for a longer period, transfer them to a CD/DVD, an
external drive, or other media.

l External—A third-party program of your choice manages the backup process. If this process
copies the local IDEXX-PACS backup folders, remind your backup vendor that these folders contain
only the last 3 days of images and data. To keep images and data for longer periods, work with your
backup vendor to establish an appropriate backup schedule and process.

l Data Only—A third-party program backs up the IDEXX-PACS images, while the IDEXX-PACS
software backs up the data files.

You can change your auto-backup option, if needed. For more information, see "Setting Up Auto-
Backup Options" on page 91. In addition, you can always back up your systemmanually, as described
below.
Follow the procedures below to perform the backup.

To back up while using the IDEXX-PACS software:

1. Do one of the following:

l In the Home window, click Tools > Backup System.
OR

l Close the IDEXX-PACS software, and click Yeswhen asked if you want to back up your system.

2. Leave the default backup folder location (C:\Program Files\IDEXX\IDEXX-PACS\backup), or click
Browse and select a different location.

Note: IDEXX strongly recommends that you back up your system to a network location.

3. ClickOK.
4. If asked whether you want to overwrite existing files, click Yes to All.

IMPORTANT: If you use the Full or Data Only backup option, you must manage the backup folder for
space.

To manually back up your data:

1. Close the IDEXX-PACS software.
2. Insert a writeable CD or DVD into your disc drive.
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3. Double-click theComputer (orMy Computer) icon on your desktop, and then double-click the
Local Disk (C:) icon in the My Computer window.

4. Double-click the Program Files folder, and then the IDEXX folder, and then the IDEXX-PACS
folder, and then the Backup folder.

5. Hold down the CTRL key while you click to select all of the following: the Images folder and each of
the three folders labeled with dates.

6. While the items are still selected, right-click any of the items and selectCopy.
7. Double-click theComputer (orMy Computer) icon again.
8. Find the drive location for your storage media (CD/DVD or other device), right-click the drive name,
and select Paste to copy the files.

9. When the files have been copied, open the drive, and verify that all of the files are there:
l Check dates of the backed-up files to ensure that they match the files in the C:\Program
Files\IDEXX\IDEXX-PACS folder.

l Check the total number of images in the backed-up Images folder to ensure that it matches the
original Images folder. The total is displayed on the left side of the window’s status bar.

To check backup status:

Backup status is visible in theConnections drop-down list in the Home window:

l Green: Backup< 3 days ago
l Yellow: Backup> 3 days ago
l Red: Backup> 2 weeks ago

Archiving Images

Unlike a backup, which saves a copy of your images and data, archiving removes image files from your
computer and saves them to a CD or DVD, or to a network location, such as a server. Archiving can
save space on your computer andmake imagemanagement easier.
You can review archived images in the Image Viewer window. For more information, see "Accessing
Archived Images" on page 57.
IMPORTANT: Store archived images in a safe location! If archived files are lost or damaged, the
images cannot be recovered.
Tip: You can set up the IDEXX-PACS software to alert you when it's time to archive images. For more
information, see "Setting Up Archive Alerts" on page 91.

To archive images:

1. In the Home window, click Tools > Archive Images.
2. Enter any or all of the following search criteria:

l Patient and client names or IDs
l A date range in which the images were captured
l Include Inactive, Include Deceased, or Show only inactive/deceased option(s)

3. Click Search. Each row in the results table represents a separate study.

4. By default, all of the studies are selected for archive; to select specific studies:
l Hold down the CTRL key and click to deselect or select individual studies.
l ClickDeselect All or Select All.
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5. In the Archive To area:
l SelectCD/DVD, and then enter the number of copies you want to make.
OR

l Select File Folder, and then enter the folder location, or click Browse and then find and select
the location. Locations can include a folder on your computer, on another computer in your
network, or on an external hard drive.

6. In the Archive Label box, enter a name for the archive file.
7. If using a CD/DVD, insert the disc; if using an external hard drive, connect the drive to your
computer.

Note: Be sure to label discs with the date. IDEXX recommends using the same format as the IDEXX-
PACS software: "IDEXX-PACS YYYY-MM-DD (#)" where # is the CD number.

8. When ready, click Archive at the top of the window.

Note: Archived images are identified by an "Archived" banner across the patient card in the Home
window.

Accessing Archived Images

When an image is archived, it is removed from the database and stored in your archive location (e.g.,
archive hard drive, CD, network server, etc.). A thumbnail of the image remains in the patient record as a
reference.

To review archived images:

1. In the Home window, search for the archived image, just as you would any image in the IDEXX-
PACS software.

An "Archived" banner is displayed over the thumbnails on the patient card.

2. To review the image, click the image thumbnail:
l If the image is readily accessible (e.g., on a networked computer or server), it opens in the
Image Viewer.

l If the image is stored in a remote location (such as a CD), a message indicates the location.
Insert the disc or browse to the location on the external hard drive or network, and clickOK. The
image opens in the Image Viewer window.

3. To reactivate this image, click on the Image Viewer window to save the images in the database.
You can now use this image like any other image in the IDEXX-PACS software.

Using IDEXX Web PACS or the IDEXX ImageBank* Storage System

IDEXXWeb PACS and the IDEXX ImageBank* storage system store your digital images securely and
affordably in the cloud. You can review your digital radiographs wherever you have Internet access,
making it easy to work from home or in the field, andmaking it simple to restore files whenever
necessary.
You should continue to back up your client and patient data and software system files using your
standard backup procedure. 57
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Activating IDEXX Web PACS

Access to the IDEXXWeb PACS software requires an IDEXX VetConnect* PLUS account, as well as an
IDEXXWeb PACS subscription.
To learn more about subscribing to IDEXXWeb PACS, contact your IDEXX representative.

How New Images Are Uploaded

When you subscribe to IDEXXWeb PACS, your images are uploaded to the cloud shortly after you
capture them or import them into your IDEXX PACS system.
The images are placed in a queue and then uploaded as your local bandwidth allows. Copies of the
images are also kept on your local system until storage limits are reached.
Uploaded images include all DICOM images that you capture, import, retrieve, or place in your watch
directory. You can upload other file types besides DICOM, as well. For more information, see "Setting
Up IDEXXWeb PACS Storage Options" on page 90.

To review the status of the image upload:

1. In the Home window, clickConnections.
2. On the ImageBank row, clickQueue.

The queue displays a list of image uploads and their progress.

Uploading Legacy (Older) Images

To upload images captured before you subscribed to IDEXXWeb PACS software (known as legacy
images), you will need an upload kit from IDEXX that contains a flash drive. Contact IDEXX Diagnostic
Imaging Customer Support for pricing and upload options.
Follow the instructions in the kit to copy the legacy images to the drive and to send the drive to IDEXX
Web PACS at AmazonWeb Services*.

Viewing Images Stored in the Cloud

To review images directly in IDEXX Web PACS:

1. In a web browser, go to vetconnectplus.com.

OR

In the IDEXX-PACS Home window, clickMenu and then click the VetConnect PLUS icon .

2. Log on to VetConnect PLUS, and then click Imaging in the VetConnect PLUS title bar.

Tip: If you are already logged on to VetConnect PLUS, the IDEXXWeb PACS software will open
automatically.

To review cloud-based images in the IDEXX-PACS* software:

1. In the IDEXX-PACS Home window, search for the patient record and the study you want.
2. Look for a small cloud icon in the upper right corner of the thumbnail on the patient card.

3. Click the thumbnail to review the images in the Image Viewer, just as you would any image stored
locally on your computer.
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Using the Sharing Window

Use the Sharing window to send images by DICOM or email, and to submit cases to IDEXX
Telemedicine Consultants.
Tip: You can send both images and ECG files from IDEXX-PACS software.

To open the sharing window:

In a patient card, click , and then click Share .
OR

In the Image Viewer, click Share in the lower right corner of the window.

To use the sharing window:

1. At the top of the sharing window, on the left, click the arrows to find and select the study date.

All studies and series for the selected date are listed below.

2. Click the Add Study or Add Series link to move the images to the right pane.

OR

Click individual images to move them to the right pane.

3. Repeat step 2 to select additional images, if needed.

Tip: To remove images from the right pane, click Remove Study or Remove Series, or click
the individual image.

4. When all the images you want to share are in the right pane, click the button for the sharing

method, for example, Telemedicine or .
5. Provide any additional information required by the sharing method.

Printing Images

You can print an image, a series, or a study.

To print an image:

1. In the Home window, find the patient record, and in the patient card click , and then click

Print .

OR

With the image open in the Image Viewer, click Print .

The Sharing window opens.
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2. Use the Sharing window to select the images you want to print. For more information, see "Using the
Sharing Window" on page 59.

3. When you have selected all the images, click .

The images open in a Print Preview window.

4. (Optional) Use the tools at the top of the window to review the images before printing.

5. When ready, click Print , specify which images to print (all or a range), and then clickOK.

6. Click to close the Print Preview window, and then clickClose to close the Sharing window.

Emailing Images

You can email an image, a series, or a study from either the Home window or the Image Viewer.
You can send the image in these formats:

l JPEG and TIFF formats, which can be opened by most Internet browsers andmany graphics
programs.

l DICOM format, which can be opened only by specialized medical or veterinary imaging software
like the IDEXX-PACS software.

Before you begin:

l Your system’s email default settings must be set up before you can email images. For more
information, see "Setting Up Email" on page 83.

l If you want to include annotations, overlays, or window/level adjustments in DICOM images, select
export options as follows:
o Go to Settings > Imaging.
o Select desired export options under Image Export on the right side of the window and then click
Save:

To email images from the Home window or the Image Viewer:

1. In the Home window, find the patient record, and in the patient card click , and then click Share

.

OR

With the image open in the Image Viewer, click Share in the lower right corner of the window.

2. Use the Sharing window to select the images you want to email. For more information, see "Using
the Sharing Window" on page 59.

3. When you have selected all the images, click .

An email message box opens.
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4. Enter the email address, a subject line, and a message.
5. Select a file format for the images.

The JPEG, JPEG 2000, and TIFF formats can be reviewed in most Internet browsers andmany
graphics programs; the DICOM format can be reviewed only by using specialized medical or
veterinary imaging software.

6. Click Send.
7. ClickClose to close the Sharing window.

Sending Images Automatically after Image Capture (Auto-Routing/Auto-Exporting)

Auto-routing sends images via DICOM® to a specified destination, such as a consultant, after image
capture. You can specify fully automatic routing or semi-automatic routing.
Auto-exporting sends copies of the images to a file folder on your computer or network.

Before you begin:

Enable the auto-routing and/or auto-exporting feature. For more information, see "Setting Up Auto-
Routing and Auto-Exporting" on page 89.

To send images via fully automatic auto-routing or auto-exporting:

No intervention is needed. The captured images are sent to the predefined destination automatically.
Use the DICOM queue to check progress, or to pause, restart, or cancel image sending. For more
information, "Using the Outbound DICOMQueue" on page 66.

To send images via semi-automatic auto-routing:

1. ClickDone at the end of the image capture session. The Send DICOMwindow opens.
2. In the Images to Send box, select the images by holding down the CTRL key and clicking image
names.

3. In the Remote Servers box, select the destination. (To send the images to more than one
destination, hold down the CTRL key while clicking the destinations.)

4. Click Send.
5. Use the DICOM queue to check progress, or to pause, restart, or cancel image sending. For more
information, see "Using the Outbound DICOMQueue" on page 66.

Using DICOM to Send and Receive Images

The DICOM® (digital imaging and communications in medicine) standard allows for the transfer,
storage, and printing of digital images between various software programs or equipment, regardless of
the manufacturer.
The DICOM queuemanages the sending and receiving of DICOM files. The DICOMQueue window
provides two tabs:

l Outbound—Lists all DICOM files being sent out of your IDEXX-PACS system
l Inbound—Lists all DICOM files being received by your IDEXX-PACS system from external sources

Sending Images to Remote DICOM Servers

IMPORTANT: Before you can send your images to other DICOM-enabled servers, you must configure
DICOM settings for the sending and receiving computers. For more information, "Overview of DICOM
Services Configuration" on page 74.
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When you send a radiograph via DICOM, the original version of the radiograph is sent (the version as it
looked when you clicked Done Capture or when you imported or received the file). Changes such as
annotations and window/level adjustments are not included. To send a version containing these
updates, contact IDEXX Diagnostic Imaging Customer Support at 1-877-433-9948. 

To send images from the Home window:

1. In the Home window, find the patient record, click expand , and then click Share .

OR

In the Image Viewer, click Share .

Use the Sharing window to select the images you want to send. For more information, see "Using
the Sharing Window" on page 59.

2. When you have selected all the images, click theDICOM button.

The Send DICOMwindow opens. The Images to Send list shows the images you have selected.

3. In the Remote Servers box, select the image destination. (To send the images to more than one
destination, hold down the CTRL key while clicking on the destinations.)

4. Click Send.
5. ClickClose to close the Sharing window.

Use the DICOM queue to check the progress of the images, or to pause, restart, or cancel image
sending. For more information, see "Using the Outbound DICOMQueue" on page 66.

Importing Images from Remote DICOM Servers Using Query and Retrieve

DICOMQuery and Retrieve lets you search for and import image studies from remote servers, so you
can review the images in the IDEXX-PACS software.

Before you begin:

The remote servers must be defined in the IDEXX-PACS software. For more information, see
"Configuring Remote DICOM Servers or Modality Worklist Connections" on page 76.

To import an image from a remote server:

1. In the Home window, click Tools > Query Retrieve.
2. Type search criteria in the search text boxes, and select the remote server from the drop-down list in
the Location box.

Tip: Servers appear in the list only if they have been defined in the IDEXX-PACS software.

3. Click Search.
4. In the search results, select the study (or studies) you want to import and click Retrieve. A message
notifies you that the study has been requested.

5. ClickOK. The software begins importing the file(s).
6. To check the status of the import request, in the Home window, clickConnections.
7. On the DICOM row of the Connections menu, clickQueue to open the DICOM queue window.
8. Select the Inbound tab, find the request in the table, and note the status in the Status column. For
more information, see "Using the Inbound DICOMQueue" on page 65.

When the status says "Complete," the study has been imported.
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9. When the import process is complete, search for and open the images as you would any other
images.

Importing Local DICOM Files Automatically

If you frequently import multiple DICOM images, you can import them automatically by placing them
into a DICOMwatch directory. The default location of the watch directory is C:\Program
Files\IDEXX\IDEXX-PACS\dicomdrop.
The software checks the watch directory at specified intervals and automatically imports any images it
finds.
Note: IDEXX recommends that you test the DICOMwatch directory with a single image to ensure that
all settings are properly configured.
You can also import DICOM images manually. For more information, see "Importing Local DICOM*
Files Manually" on page 63.

To use the DICOM watch directory:

1. Use the DICOM configuration window to specify the location of the watch directory (if you don't want
the default location) and to specify the interval at which the software checks the directory. For
information, see steps 12 and 13 in "Configuring the Local DICOM Server" on page 74.

2. When you have DICOM images to import, copy them to the DICOMwatch directory.

The images will be imported based on the specified schedule. If you are importing a large number
of images, the process may take a couple of minutes.

Importing Local DICOM* Files Manually

You can import both DICOM radiographs and DICOM ECG files (identified by a heart icon ).
You can import the files two ways:

l Based on patient ID
l By importing files directly into the currently open patient record

Both options are explained below.
Tip: You can also import DICOM files automatically by adding them to a watch directory that imports
files at specified intervals. For more information, see "Importing Local DICOM Files Automatically " on
page 63
Before you begin
The DICOM file must be located on your local computer or local network.
Importing a DICOM file based on patient ID
When you import a DICOM file this way, the IDEXX-PACS software assigns the imported file to a patient
record based on the patient ID in the imported file’s DICOM tags. If no patient record matches the ID,
IDEXX-PACS creates a new patient record for the file.

To import the DICOM file:

1. In the Home window, click Tools > Import DICOM.
2. Use the Look In drop-down list or the browsing window to locate the image.

Tip:Use these buttons to navigate to the image location:

Move up one folder
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Return to the Home folder (Desktop)

View file names only

View file details (name, size, type, and date modified)

Note: If you do not see the files displayed in the browsing window, select All Files in the Files of
Type drop-down list. This allows you to see DICOM files that have been saved without the standard
.dcm or .dic file extensions.

3. Click the file name to select it, and then click Import.

Tip: To select multiple files, hold down the CTRL key while you click the file names. (Touch screen:
you must import files individually.)

4. When the DICOM queue window opens, click the Inbound tab to review the file import status; you
may need to click Refresh to see the most current status.

5. When the import is complete, the image is added to the patient record. If the Cornerstone Software
is integrated with IDEXX-PACS software, the image will be available in the Patient Clipboard*.

Importing a DICOM file into a currently open study
When you import a DICOM file this way, the file is added to the study that is currently open in the Image
Viewer, regardless of information in the file’s DICOM tags.

To import the DICOM file directly into a study:

1. Find and open the patient study you want to add the DICOM file to.

2. In the Image Viewer window, click Tools > Import DICOM Direct.
3. Find and select the file(s) to import and then click Import.

If the imported images are not visible in the Cornerstone Patient Clipboard
This can happen if the images are not imported to the correct patient ID. In this case, you must reassign
the imported images to the correct patient ID for the images to become visible in the Patient Clipboard.

To reassign an imported image to a different patient ID:

1. In the Patient Clipboard, right-click the patient name that the imported image should be assigned to,
and then select Imaging > IDEXX-PACS image viewer. The patient record opens in the IDEXX-
PACS Image Viewer.

2. Note the patient ID located next to the patient name at the top of the Image Viewer. This is the
patient ID to which you should reassign the imported image.

3. ClickHome to display the IDEXX-PACS Home window.
4. Open the imported images from the inbound DICOM queue, as follows:

a. In the Home window, click (button color may be different).
b. On the DICOM row, clickQueue.
c. Select the Inbound tab.
d. Click Refresh to see the most recent information.
e. Double-click the row for the imported image to open the study in the IDEXX-PACS Image
Viewer.
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5. In the Image Viewer, click Reassign on the bottom right side of the window.
6. Use the Reassign window to reassign the images to the correct patient ID from step 2.

Viewing the Status of the DICOM Connection

To see the status of the DICOM connection:

1. In the Home window, click .
2. On the DICOMQueue row, note the color of the circle. It tells you the status of the DICOM
connection:
l Green—IDEXX DICOM services are running, and the queue does not contain any sent or
received images with a status of Failed.

l Yellow—Check the queue for information about sent or received images that have failed. You
may see this status when DICOM has either started or stopped.

l Gray—If DICOM services have already been configured but the connection button is gray, the
IDEXX-PACS application services are not running. You must start the IDEXX-PACS Application
Server (see below).

l Red—The DICOM server is not running. If you are using the computer that is your IDEXX
Diagnostic Imaging server, click Start on the DICOM row.

3. To open the DICOM queue, clickQueue on the DICOM row.

To start or stop the DICOM queue:

1. In the Home window, click .
2. On the DICOMQueue row, click Start or Stop.

Starting the IDEXX-PACS Application Server

If DICOM services have been configured but the DICOM connection status is inactive (the DICOM
connection button is gray), the IDEXX-PACS Application Server is not running.

To start the IDEXX-PACS Application Server:

1. PressCtrl+Alt+Delete.
2. Click Start Task Manager.
3. Click the Services tab.
4. Click theName column heading to sort the services alphabetically.
5. Scroll down until you find the service named IDEXXPACSApplicationServer.
6. In the Status column, right-click and select Start Service.
7. Click the X in the upper right corner of the window border to close the window.

Using the Inbound DICOM Queue

The inbound DICOM queue lists images that have been received by the system or are in the process of
being received.

To use the inbound DICOM queue:

1. In the Home window, click (button color may be different).
2. On the DICOM row, clickQueue.
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3. Select the Inbound tab.
4. Click Refresh to see the most recent information.

Possible Status values for inbound DICOM files are:

l Requested—Images have been requested but not yet received.
l Complete—Images were received successfully and can be reviewed in the IDEXX-PACS software.
l Receiving—Images are being received. You cannot remove images that have this status.
l Pending—Requested images are waiting to be sent.
l Failed—Images were not received successfully.

To remove a received or a failed image from the queue:

Select the image row, and then click Remove on the right side of the window.

To remove all information from the inbound queue:

ClickClear Queue.

To close the DICOM Queue window:

Click the X in the upper right corner.

Using the Outbound DICOM Queue

The outbound DICOM queue lists images that are being sent to another location.

To review the outbound DICOM queue:

1. In the Home window, click (button color may be different).
2. On the DICOM row, clickQueue.
3. Select theOutbound tab.
4. From theDestination drop-down list, select the destination you want to review.
5. Click Refresh to see the most recent information, including status.

Possible status values are:

l Pending—Images are waiting to be sent.
l Sending—Images are in the process of being sent.
l On Hold—Images are paused and will not be sent until you resend them.
l Canceled—Images will not be sent.
l Failed—Images were not sent successfully, but you can resend them.
l Permanently Failed—Image sending failed for a more serious reason and images cannot be resent.
l Complete—Images have been sent successfully.

To change the status of images in the queue:

Select the image and then use the buttons on the right:

l Send—Sends the image.
l Pause—Puts a sending or pending image on hold. The image will not be sent unless you restart it.
l Remove—Removes a selected image from the list.
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To remove Completed, Failed, and On Hold items from the outbound queue:

ClickClear Queue.

To close the DICOM Queue window:

Click the X in the upper right corner.

Importing Non-DICOM Files

You can import the following types of non-DICOM® files:

l .bmp—Microsoft Windows bitmap
l .jpg or .jp2—Joint Photographic Experts Group (JPEG) file interchange format or JPEG 2000
l .tif—Tagged image file format (TIFF)
l .avi—Audio video interleaved format
l .mpg, .mpeg—Moving Picture Experts Group format
l .ecg—Electrocardiogram files

You can also import DICOM images. For more information, see ""Importing Local DICOM* Files
Manually" on page 63.

Before you begin:

l Youmust import files into an existing patient record. If this is a new patient, create a patient record
first. For more information, see "To add a new patient without capturing radiographs" in "Adding a
New Patient and Client Record" on page 71. Then follow the steps below.

l The files to be imported must be stored on your network or local computer.

To import an image from the Image Viewer:

1. Find and open the patient study you want to add the filet to.

2. In the Image Viewer, click Tools > Import Non-DICOM.
3. Use the Look In drop-down list, or the browsing area below it, to locate the image.

Tip:Use these buttons to navigate to the image location:

Move up one folder

Return to the Home folder (Desktop)

View file names only

View file details (name, size, type, and date)

4. To look for specific file types, click the down arrow in the Files of Type box, and select the image
format.

5. Click the file name to select it, and then click Import. To select multiple images, hold down the CTRL
key while you select the files. (Touch screen: you must import files individually.)

The image opens in the Image Viewer, and a thumbnail is added to the currently open series. If there
is no current series, a new study and series are created to contain the imported file(s).
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6. Pull down the study panel at the top of the Image Viewer, and then edit the following as needed:
a. Series title
b. Capture date

7. Pull the panel back up to close it.

8. ClickHome .
9. When prompted to save the image(s), click Yes.

Importing Images by Scanning

Before you begin:

l Youmust define the scanner source in imaging settings. For more information, see "Setting Up
Imaging Units, Compression, and Export Options" on page 88.

l Scanned images must be added to a current patient record; therefore, create a new client and
patient record first, if needed. For more information, see "Adding a New Patient and Client Record"
on page 71.

To scan images:

1. Find the patient record you want to add the images to, and open it in the Image Viewer.
2. If your device scans multiple pages at one time, place the pages into the scanner, and then in the

IDEXX-PACS Image Viewer, click Tools >Multi TWAIN. The images are acquired and
displayed.

OR

If your device scans one image at a time (such as a flatbed scanner), place the image in the

scanner, and then in the IDEXX-PACS Image Viewer, click Tools > Single TWAIN. The image
is acquired and displayed. Repeat for each image you want to scan for this patient.

3. For each image, pull down the study panel at the top of the Image Viewer, and then edit the
following as needed:
a. Series title
b. Capture date

4. Pull the panel back up to close it.

5. ClickHome .
6. When prompted to save the image(s), click Yes.

Bringing a Template-Modified Image Back into the IDEXX-PACS Software

There are two ways to bring an image back into the IDEXX-PACS software after you have applied
surgical templates to it. The method you use depends on whether DICOM services are enabled on your
system.

If IDEXX DICOM Services are enabled on your system:

1. While using the template software, export the image as a DICOM file by using the Commit feature in
the template software. (See your surgical template software documentation for instructions.)

2. On the IDEXX-PACS Home window, open the study that contains the original image. The new
template-modified image is included in the same series as the original image.
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If IDEXX DICOM Services are not enabled on your system:

1. While using the template software, save the image as a JPEG file. (See your surgical template
software documentation for instructions.)

2. In the IDEXX-PACS software, open the patient study that contains the original image, and then
import the JPEG file. For more information, see "Importing Non-DICOM Files" on page 67.

The image appears in the Image Viewer window and is added to the same series as the original
image.

Note:When a template-modified image is brought into the IDEXX-PACS software, the template
becomes part of the image. If you want to save an image with a template and then make additional
modifications, you must reopen the file using the surgical template software.

Creating a Patient CD

You can create a Patient CD that contains both JPEG and DICOM versions of the patient's images, as
well as patient information and image reviewing software.
Note: The Patient CD feature is not supported on virtual machines (i.e., emulated computer systems).
By default, the images saved to the CD are the original versions (as they looked when you clicked Done
at the end of the capture process). Changes such as annotations and window/level adjustments are not
included. To create a version containing these updates, contact IDEXX Diagnostic Imaging Customer
Support 1-877-433-9948. 

To create a Patient CD:

1. Insert a writeable CD into the disc drive (a CD that can be written only once); do not use a RE-
writeable CD.

Note: You can use a DVD if you have a drive on your computer that will burn DVDs and if the
computer used to review the images has a DVD drive.

2. In the Home window, find the patient record, click , and then click Share .

OR

With any of the patient's images open in the Image Viewer window, click Share .

Use the Sharing window to select the images you want to copy to the Patient CD. For more
information, see "Using the Sharing Window" on page 59.

3. When you have selected all the images, click . The Select Export Preference window opens.
4. Enter the number of CD copies you want to make, and then clickOK.

A message states that components are being compiled.

When the CD is finished, a message states that the Patient CD is complete.

5. ClickOK. The finished CD is ejected automatically.
6. ClickClose.
7. To review the CD, see "Viewing a Patient CD" on page 70.

Note: After you create a Patient CD, you cannot add to or change the information on the CD.

Tip: You can choose to save the information to a file folder instead of a CD. See the next section.
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To save Patient CD information to a file location:

Youmight choose to save the information to a file if you want to put the images in an email or on a USB
flash drive; or you might want to compile the information for Patient CDs throughout the day and then
create the CDs at a later time using the CD-creation capabilities in Windows* software.

1. Follow the previous Patient CD creation procedure through step 6.
2. On the Select Export Preference window, select File Folder, click Browse, select a location, and
then click Save.

3. ClickOK. The files are copied to a folder at the designated location. The folder is named "PatientCD"
followed by a number. When all files have been copied, a message states that the Patient CD is
complete.

4. ClickOK.

Viewing a Patient CD

Note: The Patient CD has been tested on computers using the Windows* 10 and later operating
systems. The Patient CD and the viewer software included on the CDmay not be compatible with older
operating systems or with other operating systems, such as Mac OS X.

To review images on a Patient CD:

1. Insert the Patient CD into the CD drive.
2. Double-click theMy Computer orComputer icon on your computer desktop.
3. Double-click the icon for your CD or DVD drive. A list of files on the CD is displayed.
4. Double-click viewMyCD.bat. The Patient CD opens, displaying a viewer similar to the one in IDEXX-
PACS software

5. Use the tools at the bottom of the window to review and enhance the images.

Note: You cannot save the changes you make to the images.

6. When finished, click the X in the upper right corner of the window to close the Patient CD viewer, and
then remove the CD from the CD drive.
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IMPORTANT: If your IDEXX-PACS software is integrated with Cornerstone, ImproMed, or
AVImark software, manage all client and patient records in those software systems, not in IDEXX-
PACS. Any client or patient updates you make in the IDEXX-PACS software will not be returned to
your practice management system.

Adding a New Patient and Client Record

IMPORTANT: If your IDEXX-PACS software is integrated with your Cornerstone or AVImark
software, always add the client/patient record in the Cornerstone or AVImark software. The
record will be added to IDEXX-PACS the next time you request an image for the patient. If you
use another practice management system, be sure to add the records in both systems.

To add a new patient:

IMPORTANT: All fields are required.

1. In the Home window, enter the patient name in theNew Patient box.

Tip: If the New Patient box is not displayed, click at the top of the Home window.

2. If your system automatically assigns patient IDs, the next available ID appears in the Patient
ID box; otherwise, enter a patient ID (up to 10 characters).

3. Select the species, breed, and gender.
4. Enter an age and a date of birth, and then enter the client first and last names.
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5. Enter the client information, including a client ID, if none is displayed automatically.
6. Click Save and Continue.
7. Select radiographs, and then capture the images for the new patient.

OR

8. To save this record without capturing images, clickDone on the Shot Selection Window, and then
clickDone in the Capture window. The Home window is redisplayed.

To add a new client to an existing patient:

1. Open any of the patient's images in the Image Viewer.

2. Click Tools > Patient/Client Management.
3. In theClients section, click Add. A new client row is added.
4. Enter the new client information.
5. (Optional) To remove the previous client, click in the client row, and then clickDelete. If you do not
delete the previous client, then both clients are considered owners. You can select which client is
the primary owner.

6. Click Save.

To assign patient IDs:

If your IDEXX-PACS system is integrated with your practice information management software (PIMS),
follow these steps to assign patient IDs from that system:

1. In Global Settings, select the practice information management system (PIMS) that you use.
2. Under Client and Patient Settings, set up your system to use IDs from your PIMS.

Patient IDs from the PIMS will now be displayed in square brackets, such as [1234], throughout IDEXX-
PACS.
Tip: If you see [add ID] on the patient card, IDEXX-PACS couldn’t find a PIMS patient ID to assign; click
[add ID] to manually assign the correct ID from the PIMS.

Updating a Patient or Client Record

IMPORTANT: If your IDEXX-PACS software is integrated with your Cornerstone or AVImark software,
always update the client/patient record in the Cornerstone or AVImark software. The record will be
updated in IDEXX-PACS the next time you request an image for the patient. If you use another practice
management system, be sure to update the records in both systems.

To update a patient or client record:

1. Find the patient record.
2. Click the thumbnail in the patient card to open the Image Viewer.

3. Click Tools > Patient/Client Management.
4. If the patient does not already have an ID, enter an ID in the Patient ID box. It should be the same ID
used by your practice management system for this patient.

Note: If the ID you enter is already in use, you will have the opportunity to merge this record with the
existing record or cancel and enter a different ID.

5. Update the remaining patient information; a first and last name for the primary client are required.
6. To remove a client from this patient, click the client row in theClients section, and then clickDelete.
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7. To associate another client with this patient, click Add, and then search for and select the new client
record.

8. Click Save.

Deleting a Patient or Client Record

IMPORTANT: You cannot delete a patient record, but you can mark it as inactive, as described below.
Because all patient records must be associated with client (owner) records, you cannot delete a client
record unless you first reassign the associated patients to another client. Be sure to delete the client
record in your practice management system as well. For more information, see "Reassigning a Study "
on page 50.

To make a patient record inactive or to delete a client record:

1. In the Home window, find the patient record.
2. Click the thumbnail in the patient card to open the Image Viewer.

3. Click Tools > Patient/Client Management.
4. To make the patient record inactive, select Inactive in the upper right corner of the window.
5. To delete a client record, select the client row in the table of search results, and then clickDelete.
6. Click Save.
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Setting Up DICOM* Services
The IDEXX DICOM* Services Configuration utility lets you configure your local server so that it
can communicate with external devices (e.g., image-capture hardware and other servers),
resulting in the successful exchange of medical images and data files. Using the DICOM
conformance statements for each device, you can set up your local server to receive data from
and transmit data to a wide array of devices.
If you have any questions or require assistance as you configure your local DICOM server, call
IDEXX Diagnostic Imaging Customer Support at 1-877-433-9948. 

Overview of DICOM Services Configuration

The DICOM configuration settings ensure successful communication between your local DICOM
server and any external device. There are three steps in DICOM configuration:

1. Local Server Configuration—Configure your local DICOM server.
2. Remote Servers Configuration—Identify the external computers and devices that the local
DICOM server will communicate with. This may include your practice information
management server, and servers or devices outside your practice. Identify each device’s
name, server address, and port number.

3. DICOM file mapping—Add the manufacturers of the devices your server will communicate
with, and then specify a specific device's default location for standard text boxes (e.g.,
patient name, diagnosis, image type) as defined in the conformance statement for that
device. Then you can map that information to your local DICOM server, if necessary. This
ensures that the two devices can exchange information with each other.

After you configure your system to use DICOM, you can use DICOM query and retrieve, and you
can set up amodality worklist connection between the IDEXX-PACS* software and your
practice management system. For more information, see ""Importing Images from Remote
DICOM Servers Using Query and Retrieve" on page 62 and "Configuring Remote DICOM Servers
or Modality Worklist Connections" on page 76

Configuring the Local DICOM Server

IMPORTANT: If your Cornerstone server or your IDEXX-PACS server will send DICOM images to
other systems or receive images from other systems, configure the Cornerstone or IDEXX-PACS
server as a local server, as described below.

Define the local server configuration:

1. In the Home window, click Settings .
2. On the left side of the Settings window, selectDICOM Services and then Local Server.
3. Define Common Server Settings:
a. Enter the server's application entity title in the AE Title box.
Note: If you are setting up IDEXX DICOM services on more than one server, be sure to
give the servers different names.
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a. Enter the server port number in the Port Number box.
b. In the Transfer Queue Watch Interval box, specify (in seconds) how long the DICOM server
should wait between checking the DICOM queue for images to be sent.

4. Do not change anything in the C-Find Options area.

These advanced features should be changed only in consultation with IDEXX Diagnostic Imaging
Customer Support.

5. Define DICOM and network settings:
a. In theMaximum Number of Clients box, specify the maximum number of external devices that
can access the local DICOM server at one time.

b. In theDIMSE Timeout text box, specify the number of seconds that can elapse before the
DICOMmessage service element (DIMSE) closes communication with an external device.
After the local DICOM server opens a line of communication with an external device, it expects
to receive a request from that device within the DIMSE timeout period. If the request is not
received within the timeout period, the line is closed and the association between the two
devices ends.

c. In the Socket Close Delay text box, enter the amount of time, in milliseconds, that can pass
before the socket between the local device and an external device closes after a line of
communication has ended.
A socket is an endpoint for communication between two devices. When a socket is opened, a
line of communication (or association) is created between the two devices. When that line of
communication is ended, the socket must be closed. This text box defines how long it takes
before the socket is closed.

d. In theMaximum PDU Length text box, specify the maximum protocol data unit (PDU). This
value can be found in your local DICOM server’s conformance statement.
For example, if this value is 60 seconds and the local DICOM server has received a request to
accept an image from a device, the server will open a line of communication to the sending
device. If no image is received within 60 seconds, the local server will close the line of
communication.

e. In the Request Timeout text box, specify the number of seconds that can elapse before the
local DICOM server times out. This text box defines howmany seconds can pass after the local
server receives a request.

f. Select the Incoming DICOM Server Registration Required check box if you want the IDEXX
software to accept DICOM files only from servers that are on the remote servers list. If this check
box is not selected, DICOM files will be accepted from any remote server.

6. Specify image import settings:
a. In theWatch Directory text box, specify the folder from which DICOM services should
automatically import images. The default folder name is dicomdrop.

b. In theWatch Interval (in seconds) box, specify how frequently DICOM Services should check
the watch directory.

c. Under Image Import Settings, in the Patient Match Level drop-down list, select the information
used to match an image to a patient record:

l Patient ID—Select this option if you use IDEXX-PACS software only with IDEXX digital imaging
systems (for example, you do not import images from an ultrasound, dental, or ECG system).
The patient ID will be used to link incoming DICOM images and telemedicine reports with
patients.
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l Patient Name, Sex, Species, DOB, Client Last Name—Select this option if you use IDEXX-
PACS with non-IDEXX systems (such as an ultrasound, dental, or non-IDEXX radiography
system). The patient information will be used to link incoming DICOM images and telemedicine
reports with patients.

d. Select theUse PIMS Patient ID check box if you want to use the PIMS patient ID (as opposed
to an ID assigned by IDEXX-PACS) to assign incoming DICOM and telemedicine files to existing
patient records.

7. Click Save to save and close the Settings window, or click Apply to save without closing.

Configuring Remote DICOM Servers or Modality Worklist Connections

Note: To set up a connection with IDEXX Telemedicine Consultants, see Setting Up a Telemedicine
Connection. See "Setting Up a Telemedicine Connection" on page 78 for more information.
To enable a modality worklist connection between your practice management system and the IDEXX-
PACS software, follow the steps below to define your practice management system server as a remote
DICOM server.

To add or edit a remote or modality worklist server:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, selectDICOM Services and then Remote Servers.
3. Click Add New Server, or to edit a server, click in the server row.
4. Add or edit the following information. The person or company in charge of the remote server can
provide values for items a through d.
a. Server Name: A descriptive name of the server you want to send DICOM images to (or the
name of your practice management system server if setting up amodality worklist connection).

b. Server Address: The server’s IP address.
c. Port #: The server's port number.
d. AE Title: The application entity title (i.e., the official DICOM name of the server).
e. Support Query Retrieve: Select this box if you want to be able to search for images on the
remote server and import them into your IDEXX-PACS server. For more information, see
"Importing Images from Remote DICOM Servers Using Query and Retrieve" on page 62.

Note: Youmay need to use the scroll bar at the bottom of the table to see the Support Query
Retrieve text box.

5. If the remote server is your own practice management system server and you want to set up a
modality worklist connection to that server:
a. In theMWL SCP drop-down list, select the practice management system server.
b. If you want the IDEXX-PACS software to send status messages about the request back to that
server, select the server name in theMPPS SCP dropdown list.

c. To send status messages for images captured without an image request, select the Send
MPPS for non-requested check box.

Note: In some cases, a server is not able to receive these status messages. If so, the server will
display error messages related to the MPPSmessages. To stop receiving these error
messages, simply select the empty option in the MPPS SCP list.

6. Under PACS Server, select which server in the Remote Servers list is your IDEXX-PACS server.
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7. Click Apply.
8. To test the connection, select the server in the remote server table, and then click Test Server on
the right.
l If the test is successful, a "Test Successful" message is displayed. ClickOK.
l If the test fails, the message "Unable to echo server: ###.###.###.###" appears (# equals
the IP address of the remote server). ClickOK to continue, or clickDetails to see data about the
failure.

Recheck the information you entered, check all cords and connections, andmake sure that the
server is powered on. If the connection still fails, contact a support representative for the server
software or contact IDEXX Diagnostic Imaging Customer Support.

9. Click Save to save settings and close the window.
10. To add or edit another server, repeat steps 3 and 4.

To delete a remote server:

1. In the Home window, click Settings .
2. On the left side of the Settings window, selectDICOM Services and thenRemote Servers.
3. In the Remote Servers table, select the server, and then clickDelete.
4. Click Save to save settings and close the window, or click Apply to save without closing.

DICOM File Mapping

IMPORTANT:Do not map DICOM files unless you are experienced in working with the DICOM
standard. For help with communication between the IDEXX-PACS server and other DICOM devices,
contact IDEXX Diagnostic Imaging Customer Support (1-877-433-9948).

How fields are defined for a DICOM device

Each DICOM device has its own DICOM conformance statement. One component of this statement
defines the device’s fields.
Most manufacturers use a DICOM-standard group number and element number (such as “0008,
0070”) to define each common field (such as patient name, patient ID, study date, referring physician
name). But sometimes a manufacturer may assign a different group number and element number to
one of these common fields, or may not assign a required value to the field, or may assign a value that
must be changed for use with the IDEXX-PACS server.
When that happens, the relevant fields from the sending device must be mapped to the fields of the
IDEXX-PACS server.

How fields are mapped

TheMapping Ruleswindow lets you select a manufacturer/modality and then create a mapping rule to
map specific fields from that manufacturer to the corresponding IDEXX-PACS fields.
The window contains three tables:

l Rules table

A list of existing mapping rules.
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l Rule Triggers table

A list of tag values that, if present in a DICOM file, trigger application of the selected rule. In the
example below, the rule will be applied only if tag “0008,0070” has the value “DR30”.

Example rule trigger:

Tag Value

0008, 0070 DR30

l Rule Mapping Actions table

The mapping actions that occur when the rule is triggered. There are two possible actions: Replace
the current value of a tag with a new value, or replace the current value of a tag with the value from
another tag. You can also specify whether mapping occurs always or only if the initial tag is blank. In
the example below, the value in tag “0028, 1051” will always be replaced with the value “2000.”

Example mapping action:

Tag Action Value When

0028,1051 Replace with value 2000 Always

To map the DICOM fields:

1. In the Home window, click Settings .
2. On the left side of the Settings window, clickDICOM Services, and then selectDICOM File
Mapping.

3. In the Rules table, click , and enter a name for the new rule. The name should clearly define
the function of the rule.

4. In the Rule Triggers table, click , and enter the tag IDs and tag values that must be present in
the DICOM file for the rule to be triggered.

5. In the Rule Mapping Actions table, click , and then:
a. Enter the ID of the tag to be replaced.
b. Select the type of replace action.
c. Enter the replacement value.
d. Select the check box if the rule should be applied only when the tag is blank.

6. Click Save to save settings and close the window, or click Apply to save without closing.

Setting Up a Telemedicine Connection

To set up an online connection to your telemedicine provider:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Telemedicine Provider.
3. To add a provider, click Add.
4. In theName box, type a display name for this provider.
5. Skip the Homepage text box—it has been provided to support future functionality.
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6. In the API URL text box, type the web address for the telemedicine provider. Be sure to start the
address with http:// or https://, as instructed by your telemedicine provider.

For IDEXX Telemedicine Consultants, type the following:
https://api.vetmedstat.com/vmsintegrations/vmstms.asmx

7. In the Login and Password text boxes, type the login name and password you use to log in to the
telemedicine provider’s website.

8. In the Authentication drop-down list, choose the password authentication method that your
telemedicine provider specifies.

9. Click the row to select it, and then click Apply.
10. Click Test Tele-provider. A message tells you whether the connection is successful.
11. Click Save to save and close the window, or click Apply to save without closing.
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IMPORTANT: If your IDEXX-PACS software is integrated with your practice management
system, set all non-imaging software options (e.g., client/patient, practice/staff) in those
systems. Before modifying any exam tree (shot tree) settings, contact IDEXX Diagnostic Imaging
Customer Service.

The System Settingswindow lets you:

1. Add and delete staff members
2. Add practice information.
3. Set up DICOM® services.

4. Set up a telemedicine connection.
5. Customize your software in many other ways.

To access system settings:

1. In the Home window, click Settings . The System Settings window opens.
2. On the left side of the window, click the settings category you want.
3. In the right pane, specify the setting values.
4. Click Save to save and close the window, or click Apply to save without closing.

Setting Practice Options

IMPORTANT: If your IDEXX-PACS software is integrated with your practice management system,
set all non-imaging software options (e.g., client/patient, practice/staff) in those systems, not in
IDEXX-PACS software. Use the IDEXX-PACS options only if your IDEXX-PACS software is a
standalone system.
When you first start the IDEXX-PACS* imaging software, the Practice Configuration window
opens so that you can enter your practice information. Your installer can help you set up the
practice and staff options needed before you start using the software.
You can change these settings if necessary. Refer to the sections below the system settings
window.

Creating a System Administrator Account

When the IDEXX-PACS software is installed, there is one predefined user account named
administrator (password: admin) to allow you to log in. The administrator account cannot be
deleted.
Use this default administrator account to create another administrator account specific to your
practice.
The administrator is responsible for:

l Maintaining the IDEXX-PACS software
l Setting staff passwords
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l Designating which parts of the software each staff member can access
l Deleting images if necessary

IMPORTANT: If your IDEXX-PACS software is integrated with your Cornerstone software, set the
administrator account in that system, not in the IDEXX-PACS software. Use the IDEXX-PACS
administrator account only if your IDEXX-PACS software is a standalone system.

To create an administrator account:

1. Log on as Administrator, and type admin as the password (asterisks will appear in place of the
characters); clickOK. If this is the first time you've started the IDEXX-PACS software, you are
prompted to enter practice information:
a. ClickOK.
b. At the top of the Practice Configuration window, type the practice name and address. This
information will be printed on reports and included when you send cases to specialists.

c. To add contact information, click Add Contact and enter your phone number, a description,
and any notes.

d. Click Save.

2. In the Home window, click Settings .
3. On the left side of the System Settings window, click Practice and then:
a. Click Add to display an empty Staff Information form.
b. Type an ID for the new system administrator.
c. Enter the administrator's first and last names and other information, as needed.

4. Click Security.
5. In the Password andConfirm Password text boxes, type a password for the administrator.
6. Select the Administrator check box.
7. At the bottom of the window, click Select All to give this account access to all parts of the software.

8. When finished, click Save.

You now have a system administrator account for the IDEXX-PACS software.

Updating Practice Information

IMPORTANT: If your IDEXX-PACS software is integrated with your practice management system, set all
non-imaging software options (e.g., client/patient, practice/staff) in those systems, not in IDEXX-PACS
software. Use the IDEXX-PACS options only if your IDEXX-PACS software is a standalone system.
Practice information is printed on your telemedicine reports, included when you submit a case to a
specialist, and used when synchronizing remote andmaster computers.

To update practice information:

1. In the IDEXX-PACS Home window, click Settings .
2. On the left side of the System Settings window, click Practice.
3. At the top of the Practice Configuration window, type the practice name and address.
4. To add contact information, click Add Contact. A line is added to the Contact Information table.
5. Type your phone information, including a description and any notes.
6. To update existing information, click to select the text box and then edit the information.
7. Click Save to save and close the window, or click Apply to save without closing.
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Setting Single Species Mode

In single species mode, only one species and its related breeds are displayed as choices when you
search for patients or set up patient information.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickGlobal Settings.
3. In the Set Single Species Mode drop-down list, select the species that you want.
4. Click Save to save and close the window, or click Apply to save without closing.

Setting the Default Species

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickClient and Patient.
3. In the Species box near the bottom of the window, select the default species for new patient
records. You can always change the value when entering a record.

4. Click Save to save and close the window, or click Apply to save without closing.

Setting the System Type

The System Type options specify the kind of IDEXX Diagnostic Imaging system you are using.
DO NOT change any of the system type options without consulting IDEXX Diagnostic Imaging
Customer Support. For service within the United States or Canada, call 1-877-433-9948.

Specifying General (aka Global) Settings

Show Plate Handle Locator: Adds a marker to the image to indicate plate orientation (DR systems
only).
Enable Client Patient Security:Causes the software to display only images that you created or (if you
are a veterinarian) images that were created with your name selected as the veterinarian.
Enable Keeneland Functionality: Allows you to use a Keeneland shot tree.
Set Single Species Mode:Causes the software to display only one species and its related breeds
when you search for patients or set up patient information. Select the species you want.
Search Matching Options: Specifies requirements for entering search information. Select one of the
following:

None (no special search requirements).

[x]Characters (enter the minimum number of search characters required).

Exact Match (a full name or ID must be entered exactly).

Study Duration Preferences: Specify how long a paused study will be kept open so you can resume
taking radiographs. Select either a duration in hours or a time of day.
Practice Information Management System (PIMS): Select the practice information management
system that IDEXX-PACS is connected to. If IDEXX-PACS is a stand-alone system, selectNone.
Auto Logon: Select this option if you want users to be able to log on without entering a user name or
password. When Auto Logon is enabled, all users have administrator privileges.
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Setting Display Formats

You can specify the format to be used for dates, phone numbers, addresses, and units of
measurement.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Formats.
3. Select your preferred date and phone number formats and your preferred units of measurement.
4. Click Save to save and close the window, or click Apply to save without closing.

Setting Up Email

Tip: If your IDEXX-PACS software is integrated with your Cornerstone Software, email settings are
typically the same for both systems. However, you can change the IDEXX-PACS email settings, for
example, if you want a separate account used only for sending images.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Email.
3. In the SMTP Server Name text box, type the name of your email server.
4. In the SMTP User Name and SMTP Password text boxes, type the information that the software
needs to log into your email server.

5. In the SMTP Port text box, type the number of the port to be used for sending email.
6. In theDefault Email Attachment File Type drop-down list, select the default file format for sending
images. You can select a different format when you email images.

7. In theDefault Send Email Address text box, type the address to be listed as the sender.
8. In the Reply Email Address text box, type the address to which the recipient should reply.
9. Click Save to save and close the window, or click Apply to save without closing.

Setting Up Monitors and On-Screen Keyboard

To use multiple monitors:

IDEXX-PACS automatically detects multiple monitors and displays the Home window onmonitor 1 and
the Image Viewer on monitor 2.

To switch windows from one monitor to another:

Click and drag each window to the other monitor.

To enable the on-screen keyboard for a touch-screen monitor:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickMonitor Preferences.
3. Select Enable On-Screen Keyboard.
4. Click Save to save and close the window, or click Apply to save without closing.
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Setting Up Secure Search Display

To help protect confidentiality, you can have the search feature in the Home window return results only
after you have typed the full name exactly or only after you have typed a certain number of characters.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickGlobal Settings.
3. Under Search Matching Options, select one of the following:

l None—Returns a list of results no matter howmany characters you type.
l The middle button (in front of a blank text box and the word “Characters”)—Specifies a
minimum number of characters for searches. Type a number in the text box.†

l Exact Match—Returns results that exactly match what you type. For example, if you type Jo, the
software returns patients or clients named Jo, but not Joseph or Joe.†

Note: If you specify a required number of characters or an exact match, you must use the patient
name, the client first name, or the client last name in every search. If you search without this
information, no search results will be displayed.

4. Click Save to save and close the window, or click Apply to save without closing.

Setting Up Secure Image Display

In secure mode, the IDEXX-PACS software displays only images that you created or (if you are a
veterinarian) images that were created for you as a veterinarian.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickGlobal Settings.
3. Select the Enable Client Patient Security check box.
4. Click Save to save and close the window, or click Apply to save without closing.

Setting Up Auto-Logon

Auto-logon lets anyone at your practice use the IDEXX-PACS software without entering a user name or
password. If IDEXX-PACS software is integrated with your practice management system, logon is
automatic; you do not need to set it up.
IMPORTANT: Turning on auto-logon reduces the security of the IDEXX-PACS software. Anyone can
open the program if your computer is left unattended.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickGlobal Settings.
3. To turn on auto-logon, select the Auto Logon check box at the bottom of the window; to turn it off,
clear the check box.

4. Click Save.
5. Close and then restart the IDEXX-PACS software.
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Setting Up the IDEXX I-Vision Mobile* Application

To set up the IDEXX I-Vision Mobile* Application on an iPad tablet:

1. Open the Safari browser.
2. Type “http://” followed by the IP address or PC name for your server, and then type the following
exactly:

:8081/i-vision-mobile

For example: http://123.456.789.10:8081/i-vision-mobile

Note: The IDEXX representative who installed the IDEXX I-Vision Mobile Application should have
given you the IP address or PC name.

3. Log in to the mobile application.

4. Tap and select Add to Desktop. Be sure to do this after logging in.
5. Close the browser.
6. Tap the IDEXX I-Vision Mobile Application icon on the tablet desktop to start the application.
(From now on, always use the icon.)

To set up the IDEXX I-Vision Mobile Application on an Android™ tablet:

You’ll need both the default Android™ browser and the Dolphin Browser™ for Android.

1. Open the default Android browser.
2. Download theDolphin Browser for Android from the Google Play™ store.
3. Type “http://” followed by the IP address for your server, then type the following exactly:

:8081/i-vision-mobile

For example: http://123.456.789.10:8081/i-vision-mobile

Note: The IDEXX representative who installed the IDEXX I-Vision Mobile Application should have
given you the IP address.

4. Log on to the mobile application.

5. Tap in the upper right of the Android browser, and then tap+ (Add). Be sure to do this after
logging on to the mobile application.

6. Tap Add to home screen.

7. Tap in the upper right of the Android browser again, and then tap .
8. Tap Fullscreen. When you open the mobile application, the application will occupy the whole tablet
screen.

9. Close the browser.

10. Tap the IDEXX I-Vision Mobile Application icon on the tablet desktop to start application.
(From now on, always use the icon.)

Setting Staff Options

IMPORTANT: If your IDEXX-PACS software is integrated with your practice management system, set
all non-imaging software options (e.g., client/patient, practice/staff) in those systems, not in IDEXX-
PACS software. Use the IDEXX-PACS options only if your IDEXX-PACS software is a standalone
system.
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Adding, Deleting, Updating Staff Information

If your IDEXX-PACS software is connected to your Cornerstone software, you should manage all staff
information in Cornerstone; you do not need to follow the instructions below.
However, if your IDEXX-PACS software is a standalone system, follow the steps below to:

l Add/delete/update user information.
l Set user names and passwords. If you do not want to require user names and passwords, set up
auto-logon. For more information, see "Setting Up Auto-Logon" on page 84.

l Specify administrators.

To manage user information:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Staff Settings, and then select Staff.
3. Click Add, or select a staff name and click Edit.
4. Enter the staff member title, name, and Staff ID as needed (the ID can consist of letters, numbers, or
a combination and will become the staff person’s user name).

5. Select a classification from the drop-down list.
6. Enter the staff member’s license information (if applicable).
7. Enter any notes.
8. To enter contact information:
a. Click Add Phone to display a new row.
b. Enter a description, phone number, extension, and any notes.

9. To assign a password, or designate an administrator:
a. Click Security,
b. Provide the requested information, and then click Save.

IMPORTANT: If your IDEXX-PACS software is integrated with your Cornerstone software,
passwords are not required for IDEXX-PACS. If your IDEXX-PACS software is not integrated with
Cornerstone and you want to require users to log on, make sure that auto-logon is not selected on
the Global Settings page. For more information, see "Setting Up Auto-Logon" on page 84.

10. To mark the staff member as Inactive, clear the check box at the bottom of the window. The default
setting is Active.

11. ClickClose.

To delete a staff member:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Staff Settings, and then click Staff.
3. Select the staff member in theCurrent Staff table.
4. ClickDelete.
5. ClickClose.
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Setting Up Staff Classifications

IMPORTANT: If your IDEXX-PACS software is integrated with your practice management system, set all
non-imaging software options (e.g., client/patient, practice/staff) in those systems, not in the IDEXX-
PACS software. Set these options in IDEXX-PACS only if your IDEXX-PACS software is a standalone
system.
Staff classifications organize staff members into groups, such as doctors or technicians.

To enter classifications:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Staff Settings, and then select Staff
Classifications.

3. Click Add (or Edit if you are changing existing information).
4. In theDescription text box, type a name for a new classification or edit the current name.
5. ClickOK.
6. When you are finished, clickClose.

To set administrator privileges:

See "Adding, Deleting, Updating Staff Information" on page 86.

Changing Your Password

IMPORTANT:

l The Change Password option is not available if auto-logon is enabled.
l If your IDEXX-PACS software is integrated with Cornerstone software, no password is needed for
IDEXX-PACS.

l Passwords can also be changed on the Staff settings window.

To change your own password:

1. Click your user name in the upper right corner of the window, and then selectChange Password.
2. Enter your old password and new password as required. As you type the new password, asterisks
appear in place of the characters.

3. Click Save.

Setting Image Options

Setting Up the Plate Handle Locator

If you are using an IDEXX-DR* 1417 system, you can add a plate handle locator to your images to
indicate plate orientation.

To add the plate handle locator:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickGlobal Settings.
3. Select the Show Plate Handle Locator check box.
4. Click Save to save and close the window, or click Apply to save without closing.
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Setting Up Imaging Units, Compression, and Export Options

To set up imaging options:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Imaging.
3. In the Image Scan Settings area, do the following:
a. Select your scanner in the TWAIN Source text box.
b. Adjust the resolution values in dots per inch (dpi) in the Horizontal Resolution and Vertical
c. Resolution text boxes.
d. Adjust the pixel type (black-and-white, grayscale, or color) in the Pixel Type text box.

4. In the Image Viewer area, select a unit of measure (centimeters, millimeters, or inches) for the Ruler
annotation tool.

5. In the Image Capture Settings area:
a. From theDistance Units drop-down list, select the default unit for the distance between the
detector plate and the x-ray source.

b. From the Exposure Units drop-down list, select the default unit for x-ray exposure time
(AmpSeconds [As], milliAmpSeconds [mAs], or microAmpSeconds [µAs]).

6. UnderDICOM Compression Settings, select the compression type used when sending or saving
DICOM images:
l RAW images—DICOM images are not compressed.
l JPEGLossless—Images are compressed with little or no loss of quality.

Note: In most cases, leave the default setting (RAW). Compressing an imagemay improve image
transfer time, but it also reduces quality.

7. In the Image Export area:
a. If images look considerably different after being sent or saved with DICOM, check Apply
Window/Level to Exported Images in the Image Export area. This changes how window and
level (contrast and brightness) values are saved.

b. If you want images that you print or send to contain overlay information from the Image Viewer,
select Apply Overlays to Exported Images.

c. If you want the images that you print or send to contain annotations created from the Image
Viewer, select Apply Annotations to Exported Images.

8. Click Save to save and close the window, or click Apply to save without closing.

Setting Up the Technique Prompt

The technique prompt on the Image Capture window can display the recommended generator settings
for each shot, as determined by the technique chart that IDEXX created for your system. To set up the
technique prompt, you must enter the technique chart values.

l For a DR system, your technique chart is set up by weight. Contact IDEXX Diagnostic Imaging
Customer Support at 1-877-433-9948 if you want to use thickness instead.

l For a CR system, the chart is set up by thickness. The technique prompt is not available for IDEXX-
CR 1417 systems that do not have ClearCapture Dx* Image Processing Software installed.
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To set up the technique prompt:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Exam Trees > Capture technique chart. The
header row for a table of technique chart values appears.

IMPORTANT:Do not change any other settings related to the exam tree without consulting IDEXX
Diagnostic Imaging Customer Support.

3. In theUnit of Measurement drop-down list, select the unit you use for measuring patients, such as
kilograms (kg) or centimeters (cm).

4. Click Add. A blank row appears in the table.
5. In theMeasurement Range text box, type a range of weights or thicknesses.
6. In the kVp andmAs text boxes for each anatomical region, type the values from your technique
chart.

Note: The software extrapolates from these three general region settings to display technique
values for all shots.

7. To enter values for another anatomical thickness or weight, click Add and repeat steps 5 and 6.
8. To delete a row, click in the row to highlight it, and then clickDelete.
9. Click Save to save and close the System Settings window.
10. Restart the IDEXX-PACS software to apply the new settings.

Setting Up Auto-Routing and Auto-Exporting

Auto-routing automatically sends images by DICOM® to a specified destination, such as a consultant.

Auto-exporting lets you send images to a file folder.
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For auto-routing, you have a choice of settings:

l Manual—Deactivates auto-routing. You can still send images manually by means of DICOM. For
information about sending images manually by DICOM, see "Sending Images to Remote DICOM
Servers" on page 61

l Semi-Automatic—Lets you select the images and the destinations before sending.
l Automatic—At the end of the capture process, images are sent automatically to a designated
address.

The DICOM queue lets you check progress and pause, restart, or cancel image sending. For more
information, see"Using DICOM to Send and Receive Images" on page 61.

To set up auto-routing and/or auto-exporting:

1. In the Home window, click Settings .
2. On the left side of the System Settings window,clickDICOM Services, and then select Auto-
Routing

3. Under Auto-Routing Mode in the upper left, selectManual, Semi-Automatic, or Automatic.
4. In the Remote Servers box, select the image destination(s).
5. To auto-export the images to a file folder, select the Auto-export to file folder check box, click
Browse, and then select the folder location.

6. Click Save to save and close the window, or click Apply to save without closing

Setting Up IDEXX Web PACS Storage Options

If you subscribe to the IDEXXWeb PACS software or the IDEXX ImageBank* storage system, follow the
steps below to:

l review storage limits.
l specify the types of files you want to upload to the cloud.
l adjust how long images are stored on your local computer after being uploaded to the cloud.

Note: Your images are uploaded to the cloud automatically. Therefore, do not click the Upload button,
which is for use by customer support only, and only follow the steps for uploading images via flash drive
if you have previously purchased a legacy image upload kit from IDEXX. Contact IDEXX Diagnostic
Imaging Customer Support if you have any questions about image upload.

To review cloud storage limits and to set file types:

1. In the Home window, go to Settings > IDEXX Web PACS Storage.

Note: To change the Cloud Storage Level (the maximum number of studies you can upload per
month), contact your IDEXX representative.

2. To specify the types of files to upload to the cloud (besides DICOM), in the Upload File Types area,
select options underDICOM plus.

3. To specify how long images should remain in your local IDEXX-PACS software after being
uploaded to the cloud, select an age in days or a disk space limit.

Because your images are being stored in the cloud, copies of the images are kept on your local
system only for a limited time.

4. Click Save to save and close the window, or click Apply to save without closing.
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Setting Up Auto-Backup Options

These options control automatic backup functions, such as the time needed to shut down the server
before a backup.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Backup.
3. In the Server Shutdown Time box, enter the amount of time, in seconds, needed to shut down the
server. The IDEXX-PACS* software waits this specified amount of time before backing up.

4. In the Server Restart Time box, enter the amount of time, in seconds, needed to restart the server.
5. In the Backup Mode drop-down list, select one of these options:

l Full—The software backs up a complete set of images and the entire database (the cstone.db
file, the cstone.log file, custom .ini files, and installation configuration files created when the
program was installed). The software compares the images and data to the information in the
backup file and backs up only images or data files that have changed.

l External—You have a separate program in place to manage the backup process.

IMPORTANT: This option turns off the automatic IDEXX-PACS backup functionality. It also

disables the Backup System command in the Tools menu.

l Data Only—The software backs up only your data files. Select this option if you use a separate
program to back up your images. The Images folder will not be included in the backup process.

6. In the Backup Location box, enter the path to the desired backup location, or click Browse to find
and select the location.

7. In the Auto Backup area, specify when to back up:
l Auto Backup on Close—The system is backed up when you shut down the software.
OR

l Auto Backup Ever—The system is backed up at timed intervals; enter a number of hours.

IMPORTANT: The backup timer counts only the time the software is running. The timer stops when
you shut down the IDEXX-PACS software and resumes when you restart it.

8. Click Save.

Setting Up Archive Alerts

Archiving is not required, but if you choose to archive images, you can have the IDEXX-PACS software
alert you whenever it's time to archive. For information on how to archive images, see "Archiving Images"
on page 56.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Archive.
3. Select the Enable Archive Alerts check box.
4. In the Alert Frequency area, select whether to be alerted after a number of days or after a certain
number of images, and then set the value.

5. In the Archive Location box, specify where to store the archived files.
6. Click Save to save and close the window, or click Apply to save without closing.

When the value of days or images is reached, a message alerts you that it is time to archive your
images. You will also be prompted to archive if your Images folder nears its storage capacity.
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Setting the Duration of Paused Studies

By default a paused study closes after 4 hours, unless it is reopened before that time.
You can change the length of time a paused study remains open, up to 24 hours. Or you can choose to
close paused studies at a specific time of day, for example, at the practice's closing time.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickGlobal Settings.
3. Under Study Duration Preferences, select either Study Duration or Time of Day, and then use the
up/down arrows to set the value.

4. Click Save to save and close the window, or click Apply to save without closing.

Setting Up Imaging Shortcuts

For more information about shortcuts, see "IDEXX-PACS* Imaging Shortcuts" on page 11.

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickUser Settings.
3. Check or clear the Enable Imaging Shortcuts check box.
4. Click Save to save and close the window, or click Apply to save without closing.

Managing Favorite Shots Lists

Your favorite shots lists are displayed in tabs on the Add Shots window.

To change the order of the lists on the Add Shots window, or to delete a list:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, click Exam Trees, and then select Shot Favorites.
3. To change the order of the lists on the Add Shots window, select a list, and then clickMove Up or
Move Down.

4. To delete a favorite shots list, select it and then clickDelete.

Setting Client and Patient Options

IMPORTANT: If your IDEXX-PACS software is integrated with your practice management system, set all
non-imaging software options (e.g., client/patient, practice/staff) in those systems, not in IDEXX-PACS
software. Use the IDEXX-PACS options only if your IDEXX-PACS software is a standalone system.

Setting Up Client and Patient IDs

You have several options for how client and patient IDs are assigned and displayed in the IDEXX-PACS
software.

l Client IDs

You can choose to have IDEXX-PACS assign client IDs automatically, or you can choose to enter
client IDs manually. Follow the instructions below.
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l Patient IDs

If IDEXX-PACS is integrated with your practice information management system, you can use the
patient IDs from that system (recommended). Alternatively, you can have IDEXX-PACS generate its
own patient IDs or you can enter patient IDs manually. Follow the instructions below.

Tip: Patient IDs assigned by your practice information management system have square brackets
[1234]. Patient IDs assigned by you or by the IDEXX-PACS software have parentheses (1234).

To specify how client and patient IDs are assigned:

1. In the Home window, click Settings .
2. On the left side of the System Settings window, clickClient and Patient.
3. UnderDo you assign Client IDs in your practice? select whether to enter client IDs yourself or
have IDEXX-PACS assign them for you (if the latter, specify the number for the next client ID).

4. Under Patient ID to Display, select one of the following:
a. PIMS—Choose this option if IDEXX-PACS is integrated with your practice information
management system and you want to use that system’s patient IDs. IMPORTANT: Youmust
select your practice information management system under .

OR

b. IDEXX-PACS—Choose this option if you don’twant to display patient IDs from your practice
information management system. You can then select whether to input your own patient IDs
manually or have IDEXX-PACS assign the IDs.

5. Click Save to save and close the window, or click Apply to save without closing.

Setting Up Patient Species and Breeds

The patient species that have been preloaded into the IDEXX-PACS software include canine, feline,
equine, and several others. You can add other species and breeds as needed.

To add or edit a species or breed:

1. In the Home window, click .
2. On the left side of the System Settings window, click Species and Breeds.
3. In the Species table:

l To add a species, click Add Species, type an ID (of 1–3 characters), and type a name. Check
the box in the Large column if this is a large animal. Use the drop-down list in theWeight
column to select a measure of weight.

l To update information, select the text box you want, and then edit the information.
l To delete a species, click the row for that species, and then click Remove Species.

When you select a row in the Species table, the related breeds appear in the Breeds for table.

Note: The name of this table changes to reflect the species. For example, if the species is feline, this
table is Breeds for Feline.
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4. In the Breeds for table:
l To add a breed, click Add Breed, type an ID of no more than three letters, and type a name for
the breed.

l To update information, select the text box you want, and then edit the information.
l To delete a breed, click the row for that breed, and then click Remove Breed.

5. Click Save to save and close the window, or click Apply to save without closing.

Setting Up Patient Sex Information

Patient sex information is preloaded in your software, but you can add or change the information.

To add or edit patient sex information:

1. In the Home window, click .
2. On the left side of the System Settings window, click Sex.
3. In the Sex Information table:
a. To add a sex, click Add Sex, type a description, and, if necessary, select an option from the
Modified drop-down list.

b. To update information, select the text box, and then edit the information.
c. To delete a sex, click the row, and then click Remove Sex.

4. Click Save to save and close the window, or click Apply to save without closing.
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Using Telemedicine
You can send images to IDEXX Telemedicine Consultants or to other telemedicine providers
directly from the IDEXX-PACS* software. You can also track the status of the telemedicine case
and receive the consultant's report.
First, set up the IDEXX-PACS software to communicate with your telemedicine provider. See
"Setting Up a Telemedicine Connection" on page 78.
After the setup is complete, you can start a telemedicine case from either the IDEXX-PACS Home
window or the Image Viewer.
Note: If you choose to submit the case directly through the telemedicine provider’s website (not
through the IDEXX-PACS software), the case status will still be visible within the software, as long
as the patient is in the IDEXX-PACS database. If the patient is new, or cannot be found in the
database, you can match telemedicine results to the patient by using the telemedicine queue to
import the missing case. For more information, see "Importing Cases Submitted Outside the
IDEXX-PACS* Software" on page 96.

Submitting a Telemedicine Case

Before you can submit a case to a telemedicine provider, you must set up the telemedicine
connection. For more information, see "Setting Up a Telemedicine Connection" on page 78.

To start a telemedicine case:

1. In the Home window, find the patient record, and in the patient card click , and then click

Share .

OR

With the image open in the Image Viewer, click Share .

2. Use the Sharing window to select the radiographs to submit. For more information, see
"Using the Sharing Window" on page 59.

Tip: You can also add DICOM ECG files to the case, if you have imported them into the
IDEXX-PACS software or if the files have been uploaded from the CardioPet* software. ECG

files are identified by a heart icon .

3. Click . The telemedicine provider's website opens, and selected images are
automatically uploaded to the site.

4. Follow instructions on the website to fill out the required information, upload any supporting
files, and submit the case.

5. Close the browser window.
6. ClickClose to close the Sharing window.

Viewing the Status of a Telemedicine Case

1. In the Home window, find the patient study.

OR
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With the patient record open in the Image Viewer, find the study on the right side of the window.

A paperclip means the study is associated with a telemedicine case:

2. Note the paperclip color:
l Yellow—Submitted or in process
l Green—Completed
l Red—Error or missing information
l Gray—No images associated with case. The gray paper clip appears above the study in the
Image Viewer window.

3. Click the paperclip to open the Case window to review case details and open case reports.

Updating or Deleting a Telemedicine Case

To update or delete a case:

1. In the Home window, find the patient study.

OR

With the patient record open in the Image Viewer, find the study on the right side of the window.

You'll know a study is associated with a telemedicine case by the paperclip icon:

2. Click the paperclip to open the Case window.
3. Click View Case. The telemedicine provider's website opens.
4. On the provider's website, update or delete the case, as needed, and then close the browser.

To access the IDEXX Telemedicine Consultants website without selecting a case:

1. In the Home window, click in the upper left corner of the window.
2. Select VetMedStat. A web browser displays the website for IDEXX Telemedicine Consultants.

Importing Cases Submitted Outside the IDEXX-PACS* Software

If you submit a case to IDEXX Telemedicine Consultants outside of the IDEXX-PACS* software, the
information is still communicated to the IDEXX-PACS software, which attempts to match the submission
status and any resulting reports to the proper patient.
But if the status or report does not show up automatically, follow the steps below to manually assign the
telemedicine submission to the patient.

To assign a telemedicine submission to a patient:

1. From the Home window, clickConnections.
2. On the Telemedicine row, clickQueue. The Telemedicine Queue window opens and displays all
telemedicine submissions.
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3. If the case is not in the list:
a. Click Import Missing Case.
b. Select VetMedStat, and enter the case ID.
c. Click Import Missing Case. The case is added to the list of cases in the Telemedicine Queue
window.

4. Click Assign. The Select Client and Patient window opens.
5. Type the patient’s name or ID in the text box and click Search.
6. Select the patient and click Select. A case containing this submission is created for this patient.
7. ClickClose.

Viewing a List of All Telemedicine Cases

1. In the Home window, clickConnections.
2. On the Telemedicine row, clickQueue.

The Cases tab of the Telemedicine Queue window lists telemedicine submissions. The File Upload
tab lists files that have been uploaded to the telemedicine provider.

3. To see case details, click a case name and click View Case.
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Software Upgrades
Computer Name Length Requirements

All computers running the IDEXX-PACS software must have a computer name of 15 characters
or less, because of Microsoft limitations. If you enter a computer name longer than 15 characters,
an error will be displayed.

Assessing the detector for regulatory compliance

If you have an IDEXX-DR 1417, ImageVue DR30, ImageVue DR40, or ImageVue DR50 Digital
Imaging System with IDEXX-PACS Imaging Software, IDEXX-PACS will support a quality
assurance tool. When available in 2023, the quality assurance tool will help you to monitor
detector performance for regulatory auditing compliance.
If the quality assurance tool has already been installed, refer to the instructions provided by
IDEXX to monitor detector performance.
Be sure to look for a banner message in IDEXX-PACS for updates on tool availability.

Upgrading the Software Using SmartService* Solutions

If you have SmartService* Solutions, you will be alerted when a new software upgrade is
available. You can upgrade immediately over your network without using software CDs.
Upgrading usually takes from 15 to 60 minutes on each computer, not including the time needed
to back up your database and images.

Before you begin:

Follow your usual image storage or backup process to be sure you have a backup copy of your
database and images.

Important information if you have an IDEXX Diagnostic Imaging network:

l Upgrade the server software first. The server stores the database and image files. If you have
a backup drive, it is usually connected to the server. You must finish upgrading the server,
including step 5 in the following procedure, before you can use the software on any other
computer.

l If your server is not used for capturing radiographs, update the radiograph-capture computer
next, so that you can get back to capturing images quickly.

l After the server and capture computers are upgraded, upgrade all other computers on your
network. The other computers will not run the software until they have been upgraded.

To upgrade:

1. Close all other programs, including IDEXX-PACS software, before you start the upgrade.

2. (IDEXX-PACS 4.1 or earlier) On the server, double-click the red-and-yellow SQL icon in the
lower right corner of your desktop, and then click Exit or Shutdown. You may need to click a
small arrow in the task bar to find the icon.
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3. To start the upgrade, do one of the following:
l In the upgrade message that tells you the upgrade is available, clickUpgrade Now.

OR

l If you've closed the upgrade message, in the Home window, clickHelp > Install Updates.
4. Follow the instructions in the installation windows, and restart the server when the installation is
complete.

5. Start the IDEXX-PACS software (you may need to wait a minute or two for the software to open the
first time), and then follow the onscreen instructions to update the database and complete the
upgrade (this will take a fewminutes).

6. To upgrade workstations, start the IDEXX-PACS software on the workstation. The upgrade begins
immediately. Do not upgrade more than three workstations at a time.

Contacting IDEXX

In the U.S. or Canada:

l IDEXX Diagnostic Imaging Customer Support: 1-877-433-9948
l General sales information: 1-888-622-1962

In Europe: 00800 1234 3399
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Annotation

Explanatory notes or shapes that a user can add to an image using the tools found in the
Annotation drop-down toolbar on the Image Viewer window.

Archiving

The process of moving images to another location, such as a CD or a portable hard disk.
Generally, archiving is done to make room on the hard disk by removing images that are
unlikely to be used, such as older images. Unlike backing up, which makes copies of
images, archiving removes the primary image files from the IDEXX-PACS* Imaging Software.
Archived images can be brought back into the program if needed.

Authorization Code (Activation Key)

A code youmust enter when you start the IDEXX-PACS software for the first time after
installation. Call IDEXX Diagnostic Imaging Customer Support at 1-877-433-9948 to receive
your authorization code and clinic ID. You will need to provide the registration code that
appears in the Register window at startup.

Backing Up

The process of making a copy of images and database information in another location, such
as a tape drive or portable hard disk. If the computer is damaged, or if the information on the
computer is damaged, the images and information can be restored from the backup copy.
Unlike archiving, backing up does not remove any images from the computer; it just creates
extra copies for safety.

Bit

The basic building block of binary data, a bit is used to store information. The more bits per
pixel per color type (RGB or grayscale), the greater the detail of the image.

Bucky Tray

A shallow tray under the x-ray table that holds the detector plate or cassette.

Cases

A collection of patient images, comments, and medical history you can send to a consultant.

Capture Station

A workstation or mobile computer where radiographs are captured.

Compression

The process of condensing images for the purpose of saving space and decreasing transfer
times when transmitting images via the Internet.
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DICOM®

An acronym for “Digital Imaging and Communications in Medicine,” a standard method for
transferring images and associated information between devices created by different
manufacturers.

Image

A graphical “picture,” such as a radiograph.

Image Record

The information about an image, including a thumbnail of the image, the image title, the type of
image, the source of the image, the responsible staff member, comments about the image,
compression information, bit depth, and status.

Network

A group of computers connected together to share resources and work more efficiently.

Overlays

Information about the image that can be displayed in the Image Viewer, such as patient name, date
of birth, series title, and modality. Much of the same information is also contained in a DICOM file
created for the image.

PACS

An acronym for “picture archiving and communications system.”

Pixels

Small bits of data that make up an image.

Server

The computer that contains the IDEXX-PACS software database and copies of all the images.

Thumbnail

Aminiature copy of an image in the patient’s image record and case.

TWAIN

A standard protocol and application programming interface that enables software applications to
communicate with imaging devices (such as scanners and cameras). Applications that support
TWAIN have a standard method for acquiring images.
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Workstation

Computer connected to the IDEXX-PACS server. When images or related information is accessed
on a workstation, the workstation contacts the IDEXX-PACS server to get the images and
information.
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